
Quick guide to PsiWin
 Automatically connect to a Psion machine

PsiWin automatically searches for a connected Psion. If you prefer you can manually connect the Psion 
machine by changing the Connection properties.
To do this click the right mouse button on the Connection icon or the My Psion icon, and click Properties,
then the Connections tab.
See also Setting Connections options

 Upgrading to a Series 5 machine
Use the Upgrade to Series 5 machine program to transfer suitable files from your Series 3/3a/3c or Siena 
to your Series 5.

To start the Upgrade to Series 5 program connect your Series 3/3a/3c or Siena to the PC. Then, click the 
Start button on the Taskbar, point to Programs, point to PsiWin and click Upgrade to Series 5.

See also Upgrading files to Series 5 format
 Exchanging files between the Series 5 and a PC

Double-click a file on your Series 5 from within Windows Explorer and it’s automatically opened in the 
appropriate PC program. When the file is saved from within the PC program it is automatically converted 
back to Series 5 format and saved on the Series 5.

Drag and drop files between the Series 5 and PC drives or folders and automatically convert them to a 
suitable file format. Hold down the:

· Left mouse button as you drag the file to copy and convert the file.

· Right mouse button as you drag the file to display the menu options available. You can either copy, 
move, or copy and convert the file.

· Shift key and the left mouse button as you drag the file to move and convert the file.

Note: You can select a file format as the default conversion format for the selected file type, either in the 
Copy File dialog displayed as you drag and drop files, or on the Psion File Types tab of the Psion 
Properties dialog.

See also Managing Psion files
 Backing up the Psion machine

Use Backup to copy all the Psion machine files onto a PC or network drive. You can choose to backup the
Psion machine automatically, either on each connection or at other time intervals.

If you accidentally delete any files you can restore them from the last backup.

To start backing up, connect the Psion machine and click:

· The right mouse button on the My Psion icon and click Backup, or

· Backup Psion on the Psion menu, or

· The  button on the Toolbar.

See also Backing up a Psion machine
 Keeping archives of old and deleted files

Keep up to six archive folders of deleted or older versions of files from previous backups so that you can 
refer back to them if necessary.
To retrieve older or deleted files connect the Psion and, in Explorer, click the File Archives icon to open 
the File Archives view. Click on the archive folder you want and highlight the file(s) you want to restore.
To restore file(s) from an archive folder click:

· Restore Psion on the Backup menu to restore all changed files.

· The right mouse button and click Restore to restore just the selected file(s).



· The  button on the toolbar, to restore just the selected file(s).

See also Keeping archives (older versions of files)
 Synchronizing agendas and address books

You can use the PsiWin Synchronizer to keep parallel copies of an agenda and a Data file (e.g. an 
address book), on a Series 5 and on a PC in either Lotus Organizer (2.1 and 97), Microsoft Schedule+ (7 
and 7a) or Microsoft Outlook (97) and keep them up to date with each other. You can choose to 
synchronize your agendas automatically, either on each connection or at other time intervals.

To set up a new Agenda Synchronization connect your machine and double-click the Synchronize Psion 
icon on the Desktop. Then click the New button and follow the Synchronization wizard.

See also Synchronizing Psion and PC files
 Printing files from a Series 5

Print files from the Series 5 to any printer connected to your PC or PC network.
To select the printer you want to use:
1. Connect your machine to the PC and set it to Print via the PC.

2. Right-click on the My Psion icon and point to Properties, then click the Print Options tab.

3. Select the printer you want to use from the list of available printers and click the Set Printer button.

You can also install support for True Type fonts on a Series 5 by highlighting the required fonts and 
clicking Add followed by Install.
See also Printing

 Changing the setup of the Psion machine
Use the Properties option(s) to change the setup for the Psion currently connected to the PC.
The Properties dialog consists of six tabs; General, Connections, Backup, Psion File Types, 
Synchronization, and Print Options .

To open the Properties dialog right-click the My Psion icon, or the Connection icon on the Taskbar, and 
point to Properties.

You can also access the Properties pages by clicking on one of the PsiWin icons and then clicking:

· The right mouse button and pointing to Properties, or

· Properties on the File menu, or

· The  button on the Toolbar.

See also Changing the Psion machine properties



Quick guide to PsiWin (footnote 1)

PsiWin icons
You can access the Properties dialog for the Series 5 from any of the icons below.

Select Properties from:
The Connection icon in the Taskbar.
The My Psion icon in Windows Explorer or on the Desktop.
A drive on a Psion in Windows Explorer to display the General tab providing information about the

drive.
A folder on a Psion in Windows Explorer to display the General tab providing information about 

the folder.
A file on a Psion in Windows Explorer to display the General tab providing information about the 

file.
The Backup icon in either Windows Explorer or the Psion dialog to display the Backup and 

General tabs.
The File Archives icon in either Windows Explorer or the Psion dialog to display the Backup and 

General tabs.
The Synchronization Control Panel icon in either Windows Explorer or the Psion dialog to display 

the Synchronize tabs.



How to connect and disconnect a Psion

PsiWin can automatically detect when you connect a Psion to the PC. The Connection icon in the Taskbar
shows when the Psion is connected.

· When a Psion is connected the Connection icon looks like this: 

· If the Psion has been disconnected the Connection icon looks like this: 

Note: If your Series 5 is set to automatically turn off after a set period of time, the connection to the PC 
will be broken and the link will close. To reconnect, right-click the Connection icon  and click Connect.
If you need to use the COM port for another program, or if you want to connect a different Psion machine,
you can temporarily suspend the link to the Psion. You can also shut down the connection completely.
To close the link to a Psion:
· Right-click the Connection icon  on the Taskbar and click Close.

Note: If you close the link to a Psion you can reconnect it by double-clicking the My Psion icon on the 
Desktop and selecting the Connect command from the Psion menu.

You can also disconnect a Psion from the PC and leave PsiWin open, ready to reconnect.

To disconnect a Psion:
· Right-click the Connection icon  on the Taskbar and click Disconnect from the menu options.

Note: If you do not turn off the link on the Psion machine or unplug the cable, after a few seconds (as 
determined by the Delay between searches setting) PsiWin will reconnect to your Psion unless you have
checked the Manually connect, no auto searching option. You can change these and other options by 
clicking Properties on the menu displayed when you right-click the My Psion icon. Refer to Setting 
Connections options for more information on this.

To reconnect a Psion to the PC:
· Right-click the Connection icon  on the Taskbar and click Connect.

See also:

Setting Connections options
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About PsiWin

With PsiWin you can connect a Psion machine to a PC, and then use Windows Explorer to manage and 
exchange files on the Psion machine and the PC.

PsiWin detects when you connect a Psion machine to the PC and can automatically perform daily tasks 
such as backing up the Psion.

Note: The cable supplied with PsiWin is designed for your Series 5. Other machines may require a 
different cable.

Once you’ve installed PsiWin you can access it from:

· The My Psion icon on your desktop.

· Windows Explorer.

· The My Psion command on the Start menu.

You can use PsiWin to:
Connect the Psion machine to a PC.
Back up the Psion machine files to a PC.
Keep archives of any files that you have deleted or modified on your Psion since your last 

backup.
Transfer and upgrade Series 3/3a/3c or Siena files to a Series 5.
Synchronize your Series 5 and PC agenda and address books.
Exchange files between the Psion and PC.
Print the Series 5 files on the printer connected to your PC, whether it is directly connected or on 

a network.

Note: Updates to PsiWin will be available at Psion's discretion from:

· The Psion site on the World Wide Web at http://www.psion.com

· Psion customer services (please check the website first).

See also: 
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About PsiWin (footnote 1)

My Psion icon on the desktop

Double-click the My Psion icon on the desktop, or right-click it and click Explore, to view and manage the
disks, folders and files on the Psion.



About PsiWin (footnote 2)

Windows Explorer

PsiWin integrates with Windows Explorer and adds the My Psion icon, from which you can:

· Browse the disks, folders and files on the Psion machine.

· Manage, convert, and back up your files, and synchronize your Psion machine and PC agendas.



Psion to PC file compatibility

PsiWin provides an in-built library of file converters to make your Series 5 files compatible with leading PC
applications.

You can convert Series 5 Word files to these PC file formats:
· Word for Windows 2.0, 6.0, 95 and 97

· Word Perfect 5.1, 5.2, 6.0, 7.0 and 8.0

· Works for Windows 3.0 WP and 4.0 WP

· Ami Pro 3.0 and 3.1

· Rich Text Format

· Text for Windows (ANSI) and MS-DOS

You can convert Series 5 Sheet files to these PC file formats:
· Excel 4.0, 5.0, 95 and 97

· Lotus 123 WK1, WK3 and WK4

· Quattro Pro 5.0, 6.0, 7.0 and 8.0

· Works for Windows 3.0 SS and 4.0 SS

You can convert Series 5 Data files to these PC file formats:
· FoxPro 2.0, 2.5, 2.6 and 3.0

· Borland International dBASE III, IV and 5.0

· CSV (Windows Comma Separated Values)

· Access

Note: If your database labels contain accented characters, these may not be converted correctly and may
appear in your converted file as _ (an underscore). If this happens, simply edit the labels in your database
and overtype the _ symbols with the correct accented characters.

You can convert Series 5 Sketch files to these PC file formats:
· Windows Bitmap (.BMP)

You can convert Series 5 Record files to these PC file formats:
· Windows Wave (.WAV)

Note: PsiWin can convert Windows .WAV sound files to Series 5 format as long as they are monophonic 
(i.e. not stereo) and compressed using the PCM format. If your PC sound files are in a different format, 
you can use Windows’ Sound Recorder to convert them to a format which the PsiWin converter can 
handle.

PsiWin cannot convert Series 5 sound files which have been recorded using ADPCM compression.

You can synchronize Series 5 Agenda files with these PC file formats:
· Lotus Organizer 2.1 and 97

· Microsoft Schedule+ 7 and 7a

· Microsoft Outlook 97

Note: Microsoft Internet Explorer 4 includes a special “cut-down” version of Outlook called Outlook 
Express. Outlook Express does not have the full time-management features of Outlook 97 and you 
cannot synchronize your Series 5 Agenda with it.



See also: 

Psion to PC suite compatibility
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Psion to PC suite compatibility

The Windows programs with which you can exchange Series 5 files are from a range of application 
suites.

Series 5 files are compatible with these suites:
· Microsoft Office

· Lotus SmartSuite

· Word Perfect Suite

See also: 

Psion to PC file compatibility
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Differences from PsiWin 1.1

PsiWin is a completely new program designed for computers running Windows 95 or NT4. It will not run 
on earlier versions of Windows or in a DOS environment. There is no equivalent to the RCom program, 
which allows you to connect to PCs running DOS.

The main differences from previous versions of PsiWin include:
· Seamless integration into Windows Explorer, PsiWin no longer appears as a separate program.

· Improved file management, providing the same functionality as Windows Explorer as well as drag-
and-drop file conversion.

· Synchronization of Series 5 and PC Agendas and address books.

· Automatic detection of, and connection to, a Psion.

· Automatic communications port detection and setting of Baud rate on each connection.

· Automatic agenda synchronization and backup features.

· Automatic archiving of files that have been deleted or modified since the previous backup.

· Upgrade to Series 5 program for users of Series 3/3a/3c and Siena machines.

· Context-sensitive right mouse button menus.

All Psion file management operations can now be controlled from the PC. You can still access PC drives 
from a Series 3/3a/3c that is connected to the PC with PsiWin, but not from a Series 5.

All the features of earlier versions of Psion Manager have been retained for Series 3/3a/3c and Siena with
the following exceptions:

· Series 3/3a/3c files cannot be directly converted to PC file formats.

Tip: You can, however, convert a Series 3/3a/3c file to Series 5 machine format and then reconvert 
the new file to an appropriate PC file format.

· The Compress disk command has been removed because Series 5 programs automatically 
compress their files.

Note: The cable supplied with PsiWin is designed for your Series 5. Other machines may require a 
different cable.

See also: 

About PsiWin

Converting files between different formats

Setting Connections options
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Differences from PsiWin 1.1 (footnote 1)

Baud Rate
The speed at which electronic information travels, typically between two computers or between a 
computer and a printer, measured in bps (bits per second).

· Series 5 machines can communicate at Baud rates of up to 115200 bps.



Differences from PsiWin 1.1 (footnote 2)

Agenda Synchronization
You can use PsiWin Synchronizer to keep copies of your Agenda and address book, on a Series 5 and on
a PC - in Lotus Organizer, Microsoft Schedule+ or Microsoft Outlook 97 - and keep them up to date with 
each other.

If you are using a PC scheduler with Groupware support on a network, other people will have access to 
your PC agenda and will be able to add and view entries.



Differences from PsiWin 1.1 (footnote 3)

Backup
PsiWin provides a simple backup procedure to ensure that all the files on the Psion are kept safe. You 
can setup automatic backups, and after the first backup, further backups copy only the files which have 
changed.



Differences from PsiWin 1.1 (footnote 4)

Archiving
PsiWin keeps any files which have changed or been deleted since the previous backup in ‘Archive’ 
folders.

If you should ever need to restore an older version of a file, or one which has since been deleted from the 
Psion, you may be able to retrieve it from one of the Archive folders in Windows Explorer.



Differences from PsiWin 1.1 (footnote 5)

Upgrading to Series 5
The Upgrade program guides you through the process of transferring suitable files from your 
Series 3/3a/3c and Siena, converting them to Series 5 format, and copying them onto the Series 5.



Changing the Psion machine properties

You can use the Psion Properties dialog to set up the options relating to the Psion machine.

There is a property tab for each of these settings:
· General

· Backup

· Psion File Types

· Print Options

· Synchronization

· Connections

To open the Properties dialog:
· Right-click on the Connection icon  on the Taskbar and point to Properties, or

· Right-click on the My Psion icon on the Desktop and click Properties, or

· Click on the My Psion icon in Windows Explorer and select the Properties command from the File 
menu, or click the Properties button  on the Toolbar.

You can also access the Properties dialog for the Psion machine from any of the icons shown below:

Select Properties from:
The Connection icon.
The My Psion icon.
A drive on a Psion machine to display the General tab providing details about the drive.
A folder on a Psion machine to display the General tab providing details about the folder.
A file on a Psion machine to display the General tab providing details about the file.
The Backup icon to display the Backup and General tabs.
The Archive icon to display the Backup and General tabs.
The Synchronization icon to display the Synchronization tab.

See also: 

About PsiWin

Changing the Psion machine properties

How to uninstall PsiWin
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Changing the Psion machine properties (footnote 1)

General properties
The General tab displays general information about how the Psion is set up. The exact information 
displayed depends on where you selected the Properties option from:

· If you click Properties from the My Psion icon or the Connection icon you can view owner 
information on the General tab.

· If you click Properties from a drive on the Psion you can view information about the selected drive.

· If you click Properties from a folder or file on the Psion you can view information about the selected 
folder or file.

· If you click Properties from either the Backup or Synchronization icon you can view information about
the current setup of the selected area.



Changing the Psion machine properties (footnote 2)

Backup properties
You can use the Backup tab to specify:

· Which disks to back up.

· How often you want to back up.

· How many archives of old or deleted files you want to keep.



Changing the Psion machine properties (footnote 3)

Psion File Types properties
You can use the Psion File Types tab to view the list of Psion and PC file types available, and their 
standard conversion format.

Tip: You can change the standard conversion format for a selected file type by clicking the Edit button.



Changing the Psion machine properties (footnote 4)

Print Options properties
You can use the Print Options tab to:

· Select the Printer you want to use.

· Add/Remove fonts.



Changing the Psion machine properties (footnote 5)

Synchronization properties
You can use the Synchronization tab to specify the PC application with which you want to synchronize the
Series 5 agenda, and to enable automatic synchronization.



Changing the Psion machine properties (footnote 6)

Connection properties
You can use the Connections tab to:

· Select the COM port you’re using.

· Change the Baud rate.

· Change to manual connection instead of automatic connection.

· Access the drives on your PC from a Series 3/3a/3c.

· Synchronize the Psion and PC clocks.



How to uninstall PsiWin

If you no longer need PsiWin you can remove it from your PC. The uninstall process involves rebooting 
your PC, so you should close down any open programs before commencing uninstall.

Note: The uninstall program removes all files and folders which were added by the PsiWin installation 
program, but does not remove backed-up and archived files or synchronization data. Therefore, if you 
subsequently reinstall PsiWin you will be able to back up, restore, and synchronize using the same 
settings as before. If you do not want to keep this information you can delete all information connected 
with an individual owner, or with all owners. For further information, see Removing owner information with 
the Owner Manager.

· You can also manually delete the folder where the Psion files are kept (this is C:\Psion unless you 
have specified a different folder in the General Properties dialog).

To uninstall PsiWin:
1. Click the Start button on the Taskbar, point to Settings, and click on Control Panel.

2. Double-click the Add/Remove Programs icon and select PsiWin 2.1 from the list of installed 
programs.

3. Click the Add/Remove button and click Yes to confirm that you want to remove all the installed 
components (or click No to exit).

The uninstall program commences and informs you that you need to restart your PC in order to 
complete the uninstallation process.

Note: If you have installed Internet Explorer 4 and have customized your Desktop or Taskbar by 
creating any PsiWin Toolbars, you must remove them before continuing the uninstall process.

4. Click OK to continue, or Cancel to exit the uninstall program.

5. Click the Start button on the Taskbar and click on Shut Down.

6. Select Restart the computer and click Yes to confirm.

When your PC restarts, the uninstall program will proceed to uninstall PsiWin.

· During the uninstall procedure you are asked whether you want to remove some files which may also 
be used by other programs. As a general rule it is safe to click Yes to All. If you are in doubt, check 
the location of each file and:

– Click Yes when asked if you want to delete a file which is in the PsiWin folder (unless you chose a 
different folder during installation, this is C:\Program Files\Psion\PsiWin).

– Click No when asked if you want to delete a file which is in the Windows\System folder.

· When uninstallation is complete you may get a message informing you that some items could not be 
removed (see Note above).

See also: 

Removing owner information with the Owner Manager

About PsiWin

Differences from PsiWin 1.1
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Accessing Help

You can access PsiWin’s Help at any point while you are working with PsiWin by:

· Clicking Help Topics on the Help menu, or

· Pressing F1, or

· Clicking the Help button in a dialog.

· Selecting a Psion drive and clicking the Help menu in Windows Explorer.

You can also access Help without starting PsiWin by clicking the Start button on the Taskbar, pointing to 
Programs, pointing to PsiWin and then pointing to PsiWin Help.

See also: 

Navigating Help

Printing Help

Quick guide to PsiWin



Navigating Help

The topics in the Help are listed on the Contents tab of the Help Topics window, and are divided into 
‘books’ containing ‘pages’ of Help. You can:

· Open a book to display the pages of Help within it by double-clicking a , or by highlighting a 
 and clicking the Open button.

· Close a book by double-clicking a  , or by highlighting a 
 and clicking the Close button.

· View a page of Help by double-clicking a , or by highlighting a 
 and clicking the Display button.

The Psion Help window contains the Help on the selected topic, and these buttons:

 Redisplays the Help Topics: Table of Contents window.

 Redisplays the last topic you viewed.

 Displays the Options menu.

 Displays the next page of Help in the current group of topics.

 Displays the previous page of Help in the current group of topics.
There are also jumps to other topics and pop-up windows within topics:

· Text which is green with a dotted underline displays a pop-up window providing extra information.

· Text which is green with solid underline is a Jump to another page of Help.

See also: 

Printing Help

Searching for Help
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Navigating Help (footnote 1)

Options menu



Navigating Help (footnote 2)

Pop-up window
This is an example of a pop-up window. Click anywhere on the page to close this window and return to 
the previous Help topic.



Searching for Help

If you can’t find the topic you want on the Contents tab of the Help Topics window, you can search for 
information using one of these tabs:

· Index

· Find

To search the Index:
1. Click on the Index tab in the Table of Contents window.

2. Type the letters or word you want to search for. As you type, matching entries are displayed in the 
lower portion of the window.

3. Highlight the Index entry you want.

4. Click the Display button to either:

– Display a list of topics about the selected entry on the Topics Found window. Highlight the topic 
you want and click the Display button to read the topic.

– Open the one Help topic relating to the index entry on the PsiWin Help window.

To search using the Find tab:
1. Click on the Find tab in the Table of Contents window.

The first time you use the Find tab you need to specify how extensive you want the search to be. The 
Find Setup Wizard is displayed when you click on the Find tab for the first time. This wizard guides 
you through the process of creating the list of words to search through.

2. Type the letters or word you want to search for. As you type, matching words are listed.

3. You can narrow the search by highlighting one of the matching words.

4. Highlight the topic you want in the lower portion of the window and click the Display button to read the
topic.

See also: 

Printing Help
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Searching for Help (footnote 1)

Index tab
You can use the Index tab to base your search on the index entries for the Help file.



Searching for Help (footnote 2)

Find tab
You can use the Find tab to search for words or phrases used anywhere in the topics on the Table of 
Contents window.



Printing Help

To print out one or more topics in Help:
1. If necessary, click the Help Topics button to display the Table of Contents window.

2. Highlight the topic, or book of topics, you want to print.

3. Click the Print button.

4. Select the number of copies you want to print in the Print dialog.

Note: You can select the printer you want to use by clicking the Properties button in the Print dialog.

5. Click the OK button to start printing.

Tip: You can print out the Help topic from the PsiWin Help window by clicking Print Topic from the 
Options button, or from the menu displayed when you click the right mouse button anywhere on the 
window.

Tip: You can print the information in a pop-up window by clicking the right mouse button inside the pop-up
window to display the right mouse options available, and clicking Print Topic to display the Print window.

If you prefer, you can print out the whole of the Help text as a “User Manual”. In order to do this you need 
to have Adobe Acrobat Reader installed on your PC (if you don’t have Acrobat Reader, the installation 
program is included with PsiWin). Acrobat Reader is also needed to view much of the other 
documentation on the PsiWin CD-ROM.

· Adobe Acrobat Reader is a utility provided free by Adobe Systems, Incorporated, and is included with 
PsiWin 2. If you already have Acrobat Reader installed, or if you do not want to install it, you can 
delete the file ar32e30.exe from your PsiWin folder. If you subsequently want to install Acrobat 
Reader you can double-click on this file in the PsiWin folder on the PsiWin 2 CD-ROM.

Note: Once you’ve printed the manual you can uninstall Acrobat Reader if you want, using the 
Add/Remove Programs option in Windows Control Panel.

To install Acrobat Reader:
· Click the Start button on the Taskbar, point to Programs, point to PsiWin and then click on Install 

Acrobat Reader.

To print the User Manual:
1. Click the Start button on the Taskbar, point to Programs, point to PsiWin and then click on User 

manual.
2. In Acrobat Reader, click Print on the File menu.

Note: When you view the User Manual (or any of the other .PDF files included with PsiWin) in Acrobat 
Reader, you may find that the text isn’t displayed clearly on screen. You can correct this in Acrobat 
Reader by pointing to Preferences and clicking General on the File menu. Then, deselect the Smooth 
Text and Monochrome Images check box and click OK.

See also: 

Accessing Help
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Printing Help (footnote 1)

Right mouse options



Converting files between different formats

You can use PsiWin to exchange files between a Series 5 and a PC.

You can convert these file types:
Word.
Sheet.
Data.
Record and Voice Notes.
Sketch.

· To convert an Agenda file and open it on a PC you need to use Agenda synchronization.

Notes on converting Word files:
If you use Microsoft Word’s “Fast Saves” option you may find that your converted files contain extra text 
from previous versions of your files. For best results you should disable “Fast Saves” (on the Save tab of 
the Tools-Options menu command) before converting.

If you convert a PC word processor document containing a table to Series 5 Word, the table will appear 
as an inserted Sheet object. If any of the cells in the table contains a large amount of text this may be 
truncated, since Series 5 Sheet cells cannot contain more than 255 characters.

Notes on converting Sheet files:
If your PC Spreadsheet contains multiple Worksheets, these will all be combined into a single Series 5 
Sheet file. Series 5 Sheet does not use Worksheets.

Notes on converting Record and Voice Notes files:
PsiWin can convert Windows .WAV sound files to Series 5 format as long as they are monophonic (i.e. 
not stereo) and compressed using the PCM format. If your PC sound files are in a different format, you 
can use Windows’ Sound Recorder to convert them to a format which the PsiWin converter can handle.

PsiWin cannot convert Series 5 sound files which have been recorded using ADPCM compression.

Notes on converting Password-protected files:
You cannot convert password protected files (including password-protected memos in Agenda). If you 
want to copy a password protected file between a Series 5 and a PC you need to remove the password 
on the Series 5 before converting the file.

See also:

Using the Psion File Converter

How to convert files

Managing Psion files

How to upgrade to a Series 5
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Converting files between different formats (footnote 1)

Agenda Synchronization
You can use the PsiWin Synchronizer to keep copies of your Agenda, on a Series 5 and on a PC (in Lotus
Organizer, Microsoft Schedule+ or Microsoft Outlook), and keep them up to date with each other.

If you are using a PC scheduler with Groupware support on a network, other people will have access to 
your PC agenda and will be able to add and view entries.



How to convert files

You can convert files to and from Series 5 format, without having to have a Series 5 connected, using the 
Psion File Converter. You can also exchange files between the Series 5 and a PC and convert them, if 
desired, by dragging and dropping them between your Series 5 and PC in Windows Explorer.

There are several different options you can choose from when transferring files between the Series 5 and 
a PC.

You can:

· Copy and convert a file.

· Copy a file without converting.

· Move and convert a file.

· Move a file without converting.

· “Send” and convert a file to a Psion from within Windows Explorer using the Psion File Converter.

Tip: When you convert a file you can set up a default conversion for each different file type, so that PsiWin
automatically converts files you drag between the Series 5 and the PC to the right format.

You can convert Series 5 files to any of the PC application file types listed, even if the application is not 
present on the PC.

See also:

Using the Psion File Converter

Copying and converting files

Copying without converting

Moving and converting files

Moving without converting

Sending PC files to a Psion

Upgrading files to Series 5 format
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Using the Psion File Converter

You can convert files between Psion and PC formats without having to connect your Series 5. This can be
useful if, for example, you have backed up your Series 5 files and want to work on them while your 
Series 5 is not connected.

To convert between Psion and PC formats:
1. Right-click the My Psion icon and click Convert files, or

Click the Start button, point to Programs, point to PsiWin 2.1, and point to Convert files.

2. In the From box, click the browse button  and select the file you want to convert.

PsiWin examines the file and suggests a file type and location for the converted file (it may take a few
seconds for the converters to load).

3. If you want to change the location of the converted file, click the browse button  and select a new 
location.

If you want to change the type of the converted file, click the arrow next to the drop-down list  and 
select a different type from those available.

4. Click Convert Now to convert the file.

See also:

Copying and converting files

Setting the default conversion format

Converting files between different formats
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Copying and converting files

The first time you copy and convert a file between a Series 5 machine and a PC you need to specify the 
file type you want to convert it to.

Tip: You can select a default conversion format for all files of a certain type and choose not to display the 
Copy dialog again.

To copy and convert a file:
1. Highlight the file you want to copy and convert on the Series 5 or PC.

2. Drag the file to a folder on the PC, or on the Series 5.

Tip: You can copy and convert a file by holding down the right mouse button as you drag the file and 
selecting Copy here and Convert.

3. The Copy dialog is displayed. Select the file type you want to convert to from the drop-down Type list. 
You can also:

– Click the Set as Default button to make this the default conversion format for files of this type.

– Select the Don’t show this dialog again check box to always convert files of this type to the 
selected file type and not show the Copy dialog.

Tip: If you opt not to show this dialog again you can change the default conversion using the Psion 
File Types tab on the Psion Properties dialog. To open the Psion Properties dialog click Properties 
on the menu displayed when you click the right mouse button on the My Psion icon.

– Copy the file instead of converting it by clicking the Copy Only button.

– Cancel the conversion by clicking the Cancel button.

4. Click on the Convert button to copy and convert the file.

Some formatting in converted files might be lost.

See also: 

Converting files between different formats
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Copying without converting

You can copy files and folders between the Psion machine and a PC without converting them.

To copy without converting:
1. Highlight the file, or folder of files, you want to copy.

2. Hold down the right mouse button and drag the file to a folder on the PC or the Psion. As you drag the
file the available menu options are displayed.

3. Click on the Copy Here option and the file is copied.

Tip: Alternatively, you can copy a file by dragging it while holding down the left mouse button, and clicking 
Copy Only in the Copy dialog.

See also: 

Converting files between different formats
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Moving and converting files

The first time you move a file(s) between a Series 5 machine and a PC you need to specify the file type 
you require.

Tip: You can select a file type to be the default conversion for all files of a certain type and choose not to 
display the Copy dialog again.

To move and convert a file:
1. Highlight the file(s) you want to move and convert, on the Series 5 or PC.

2. Hold down the Shift key and the left mouse button, and drag the file to a folder on the PC.

3. The Move File dialog is displayed. Select the file type you want to convert to from the drop-down list 
in the Type field. You can also:

– Click the Set as Default button to make this the default conversion format for all files of this type.

– Opt not to show the Move File dialog again and always convert files of this type to the file type 
selected by clicking the Don’t show this dialog again check box.

Tip: If you opt not to show this dialog again you can change the default conversion using the Psion 
File Types tab on the Psion Properties dialog. To open the Psion Properties dialog click Properties on 
the menu displayed when you click the right mouse button on the My Psion icon.

– Move the file, instead of moving and converting it, by clicking the Move Only button.

– Cancel the conversion by clicking the Cancel button.

4. Click on the Convert button to move and convert the file.

Some formatting in converted files might be lost.

See also: 
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Moving without converting

You can move file(s) and folders between the Psion machine and a PC without converting files.

To move without converting:
1. Highlight the file or folder of files you want to move.

2. Hold down the right mouse button and drag the file to a folder on the PC or the Psion. As you drag the
file the available menu options are displayed.

3. Click on the Move here option.

See also: 
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Converting Series 3/3a/3c and Siena files

You can convert the files on your Series 3/3a/3c or Siena machine to Series 5 file format. This is a one-
way process; Series 5 files cannot be converted to Series 3/3a/3c or Siena format.

Series 3/3a/3c or Siena files can be converted by dragging and dropping them between the 
Series 3/3a/3c or Siena and the PC, in the same way that you copy and convert Series 5 files, and 
selecting the appropriate format to convert to.

Note: You cannot convert Psion Series 3/3a/3c files directly to PC application format. If you want to open 
a Series 3/3a/3a or Siena file on a PC you should first convert it to Series 5 format and then reconvert it to
the PC format.

Note: You can automatically convert and transfer all suitable files from your Series 3/3a/3c and Siena to a 
Series 5 using the Upgrade program.

The Series 5 Data program does not allow you to create a new file (or edit the labels in an existing 
database) with two labels that are the same, whereas the Series 3/3a/3c and Siena databases do allow 
this. If your Series 3/3a/3c or Siena database contains two labels that are the same it will be correctly 
converted to Series 5 format and you will have a Series 5 Data file with two labels the same. However, if 
you were then to attempt to merge the contents of the converted data file into an existing Series 5 Data 
file - for example, in order to increase the field sizes - the merge would fail. For this reason, it is advisable 
to rename any duplicate labels in converted Data files.

Note: The cable supplied with PsiWin is designed for your Series 5. Other machines may require a 
different cable.

See also: 
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Psion and PC file compatibility

You can convert your Series 5 files to any of the file types listed below, even if the PC application isn’t 
currently installed on the PC. It just means that you can’t open the file on the PC.

You can convert Series 5 Word files to:
· Word for Windows 2.0, 6.0, 95 and 97

· Word Perfect 5.1, 5.2, 6.0, 7.0 and 8.0

· Works for Windows 3.0 WP and 4.0 WP

· Ami Pro 3.0 and 3.1

· Rich Text Format

· Text for Windows (ANSI) and MS-DOS

You can convert Series 5 Sheet files to:
· Excel 4.0, 5.0, 95 and 97

· Lotus 123 WK1, WK3 and WK4

· Quattro Pro 5.0, 6.0, 7.0 and 8.0

· Works for Windows 3.0 SS and 4.0 SS

You can convert Series 5 Data files to:
· FoxPro 2.0, 2.5, 2.6 and 3.0

· Borland International dBASE III, IV and 5.0

· CSV (Windows Comma Separated Values)

· Access

Note: If your database labels contain accented characters (e.g. é), these may not be converted correctly 
and may appear in your converted file as _ (an underscore). If this happens, simply edit the labels in your 
database and overtype the _ symbols with the correct accented characters.

You can convert Series 5 Sketch files to these PC file formats:
· Windows Bitmap (.BMP)

You can convert Series 5 Record files to these PC file formats:
· Windows Wave (.WAV)

Note: PsiWin can convert Windows .WAV sound files to Series 5 format as long as they are monophonic 
(i.e. not stereo) and compressed using the PCM format. If your PC sound files are in a different format, 
you can use Windows’ Sound Recorder to convert them to a format which the PsiWin converter can 
handle.

PsiWin cannot convert Series 5 sound files which have been recorded using ADPCM compression.

You can synchronize Series 5 Agenda files with:
· Lotus Organizer 2.1 and 97

· Microsoft Schedule+ 7 and 7a

· Microsoft Outlook 97

Note: Microsoft Internet Explorer 4 includes a special “cut-down” version of Outlook called Outlook 
Express. Outlook Express does not have the full time-management features of Outlook 97 and you 
cannot synchronize your Series 5 Agenda with it.



See also: 
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Psion and PC application suite compatibility

The Windows programs with which you can exchange Series 5 files are from a range of application 
suites.

Series 5 files are compatible with these suites:
· Microsoft Office

· Lotus SmartSuite

· Word Perfect Suite

See also: 

Converting files between different formats

Psion and PC file compatibility
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Changing the file format for conversions

The first time you copy a file from the Series 5 to a PC you need to specify the file type you want to 
convert the file to.

You can also choose a default conversion format for the file type and select not to show the Copy or Move
File dialog again. These conversion settings are specific to individual Series 5 machines, so different 
machines can have different default conversion formats. If at a later stage you want to change the default 
conversion, you can change the conversion file type for any Series 5 file types, or just the currently 
selected type.

Note: To change the default conversion format for the Series 5 you need to connect the machine. This is 
because more than one person can connect their Series 5 to the same PC, so the Series 5 needs to be 
connected to determine the existing conversion setup for that machine.

See also: 

Converting files between different formats
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Setting the default conversion format

You can change the default conversion for any of the Series 5 file types by changing the general setup of 
the Series 5.

To change the default conversion for any Series 5 file type:
1. Connect the Series 5 to the PC.

2. Select the Properties option from either the File menu in Windows Explorer or from the menu 
displayed when you right-click on the My Psion icon.

3. Click on the Psion File Types tab in the Psion Properties dialog to display a list of all the Psion file 
types available.

Tip: Click on one of the Registered file types to see which file type the file is currently converted to.

4. Click on the file type you want to change and click the Edit button.

5. Click on the file type to which you want to convert files of this type in the Edit File Type dialog.

6. Click on the Set Default button to make the selected file type the default conversion format.

7. You can choose not to show the Copy or Move File dialog while converting files by deselecting the 
Display choice of converters check box.

8. Click Apply to save the new default conversion format without closing the Edit File Type dialog, or 
click OK to save the new conversion format and return to the Psion Properties dialog.

See also: 

Converting files between different formats

Setting the default conversion for one file type
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Setting the default conversion for one file type

You can change the default conversion for just the currently selected file type.

To change the default conversion for one Psion file type:
1. Connect the Psion to the PC.

2. Click on one of the files whose conversion format you want to change, on the Psion.

3. Select the Properties option from either the File menu in Windows Explorer or from the menu 
displayed when you click the right mouse button on the file.

Tip: The current conversion format for the Psion file type is displayed on this dialog.

4. Click on the Change button in the Properties dialog.

5. Click on the file type to which you want to convert this type of file.

6. Click on the Set Default button to make the selected file type the default conversion format in the Edit
File Type dialog.

7. Click Apply to save the new default conversion format without closing the Edit File Type dialog, or 
click OK to save the new conversion format and return to the Properties dialog for the selected file.

See also: 
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Solving file conversion problems

If you cannot convert a particular file, it may be because of one of the following reasons:

· PsiWin may not be able to convert files of this type.

Check the Psion File Types Properties page (see Viewing Psion file types) and ensure that the file 
type is listed.

· The file may be corrupt.

Try opening the file in the source program and saving it under a different name.

· The file may already be open in another program.

Check, and close it if necessary.

· If it is a PC file, it may have the wrong filename extension.

Try double-clicking the file in Windows Explorer to check that it can be opened by the program 
associated with that filename extension. If not, the extension may be incorrect.

· If it is a Word or Sheet file, it may be password-protected (if you receive Error message (86) this is 
almost certainly the case).

Open the file in the source program, remove the password and try again.

If you convert a PC word processor document containing a table to Series 5 Word, the table will appear 
as an inserted Sheet object. If any of the cells in the table contains a large amount of text this may be 
truncated, since Series 5 Sheet cells cannot contain more than 255 characters.

See also:

Viewing Psion file types

Converting files between different formats
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Opening Series 5 files in PC programs

You can open your Series 5 files on your PC in an appropriate PC program, edit them, and save them 
back onto your Series 5.

To open a Series 5 file in a PC application:
1. Double-click the Series 5 file in Windows Explorer.

PsiWin creates a temporary copy of the file and opens the Select Type of Conversion… window.

2. Select a PC program from the drop-down list.

If you will always want to open Psion files of the current type in this program, you can click Don’t 
show this dialog again. 

3. Click Convert.

The temporary file is converted to the selected format and opened in the appropriate PC program.

When you select the Save command from the PC program’s File menu, or exit the PC application, the file 
is automatically converted and saved back your Series 5 in its original format. If you have edited the file, a
copy of it is saved back to the Series 5 with the word “modified” appended to its name. You can then 
check the new file against the original, if you wish, before you delete the original.

Some formatting in converted files may be lost. For this reason, a copy of the file is saved back to the 
Psion.

Note: If your Series 5 should switch itself off, or become disconnected, while you are working on one of its
files, the “Current open files” dialog appears when you attempt to save the file. You are then given the 
option of reconnecting to the Psion or saving the file onto the PC.

See also:

Checking which Series 5 files are open on the PC
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Checking which Series 5 files are open on the PC

If you use your PC programs to view or edit your Series 5 files (see Opening Series 5 files in PC 
programs) you can check which Psion files are currently open on your PC.

You might like to do this if your Series 5 has become disconnected from your PC, or before disconnecting 
your Series 5. You can then save open files to your Series 5 in Psion file format, save them to your PC in 
PC file format, or delete the temporary files.

To view a list of all the Series 5 files currently open in a PC program:
1. Open Windows Explorer.

2. Left-click on the My Psion icon.

3. Select the View open files command from the Psion menu.

4. Select the Only show modified files option if you only want to see those files which have been 
changed since they were opened.

When you edit a Series 5 file in a PC program you are actually working on a copy of the file, stored in a 
temporary folder on the PC. When you have finished editing the file, a copy of it is saved back to the 
Series 5 with the word “modified” appended to its name and the temporary file is deleted.

If you want, you can save an open file to a different location. If the Series 5 should be disconnected 
before the file can be saved back, you can save the modified file to a different location in the same way.

To save an open Series 5 file back to the Series 5:
1. Ensure that the Series 5 is connected.

2. Highlight the desired file(s) and click the Save to Psion button.

To save an open Series 5 file to a PC:
· Highlight the desired file and click the Save to PC button.

Note: you cannot select multiple open files to save to a PC; you must save each one individually.

If your Series 5 should become disconnected, the temporary file is not deleted and the next time you 
connect you are given the option of saving the modified file back to the Series 5. If you are sure you do 
not want to keep the modified version you can delete the temporary file.

To delete a temporary file:
· Highlight the file and click the Delete button.

See also:

Opening Series 5 files in PC programs
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Managing Psion files

You can perform the same tasks with the Psion files in Windows Explorer as you can with files on the PC.

You can:
· Copy files by dragging them between folders.

· Move files by holding down the shift key as you drag the file.

· Cut and copy files, then paste them into a folder on your PC, converting them to a PC file type if 
required.

· Send a file to a Psion disk and automatically convert it to a Psion file type.

· Rename files or folders by clicking Rename on either the File menu, or the menu displayed when you
click the right mouse button on a file or folder.

· Delete files of folders by pressing the Del key, or by clicking Delete on either the File menu or the 
menu displayed when you click the right mouse button on a file or folder.

If you delete a file (or folder) from the Series 5, the file does not go into the Windows Recycle bin and 
cannot be restored.

· Create a new folder by pointing to New and clicking Folder on the File menu.

You cannot search for a file on the Psion using the Find option.

Tip: Click the right mouse button to display a menu containing the options currently available and to 
change the setup for any tasks you’ve chosen to perform automatically by clicking the Properties option.

See also: 
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Sending PC files to a Psion

You can quickly “send” any file, or group of files, to any connected Psion disk from within Windows 
Explorer. Files “sent” to a Psion are automatically converted to the appropriate Psion file types.

To send a file to a Psion:
1. Open Windows Explorer and browse to the desired file.

2. Right-click on the file.

3. Point to Send to, and then click either My Psion (C Drive) or My Psion (D Drive).

The file is converted to the default Psion format and copied to the root of the specified drive.

To send several files to a Psion:
1. Open Windows Explorer and browse to the folder containing the files.

2. Hold down the Shift key and left-click on each of the files you want to send to the Psion.

3. Right-click on any of the selected files, point to Send to, and then click either My Psion (C Drive) or 
My Psion (D Drive).

The files are converted to the default Psion formats and copied to the root of the specified drive.

See also:

Setting the default conversion format

Managing Psion files
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Viewing disk information

You can see how much disk space you’ve used, and the amount still available, on any of the Psion disks.

To view disk information:
1. Open Windows Explorer and left-click on the My Psion icon.

2. In the right-hand pane, click on the disk for which you want to view disk information.

3. Select Properties from either the File menu or from the menu displayed when you right-click the 
mouse button.

The Properties dialog is displayed, listing these details:

– The amount of disk space used.

– The amount of disk space free.

– The total amount of disk space for the selected disk.

4. Click the OK button to close this dialog.

See also: 

Understanding Psion machine and disk names

Viewing file and folder information
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Viewing file and folder information

You can view information about the selected file or folder on the Psion machine.

To view file or folder details:
1. Open Windows Explorer and left-click on the My Psion icon.

2. In the right-hand pane, click on the file or folder for which you want to view information.

3. Select Properties from either the File menu or from the menu displayed when you right-click the 
mouse button.

You can view these details about folders:
· Location of the folder.

· Size of the folder.

· Time and date on which the folder was last modified.

· Number of files in the folder.

You can view these details about files:
· Type of file and the format it converts to by default.

· Location of the file.

· Size of the file.

· Time and date on which the file was last modified.

See also: 

Viewing disk information

Converting files between different formats
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Viewing Psion file types

You can view the list of Psion file types available, and if necessary change the default conversion format 
for the files.

To view Psion file types:
1. Click on the My Psion icon in Windows Explorer.

2. On the View menu, click Options to display the Options dialog.

3. Click the Psion File Types tab to view the list of Psion file types.

4. If you want to change the default conversion format for any of the file types, click on the file type you 
want to change and then click the Edit button.

Refer to Setting the default conversion format for more information.

5. Click OK to close the Options dialog.

See also: 

Managing Psion files
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Troubleshooting

If you encounter any problems while using PsiWin to manage your files and disks, check the following:

· The link on the Psion machine is correctly enabled.

· The Psion and PC are using the same Baud rate.

· The PC is searching the correct COM port(s).

· The Docking cable is connected to both the Psion and the PC.

· The file is not password protected.

· If you are converting a file, make sure the file type is supported.

· If you are copying or moving a file, make sure the destination disk is not full.

Tip: You can check the communication options between the Psion and PC on the Communications tab 
on the Psion Properties dialog. To access this dialog right-click on the My Psion icon, or the Connection 
icon on the Taskbar, and point to Properties.

See also: 

Converting files between different formats
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Identifying your Psion machine

You need to enter an owner name for each of the Psion machines that you connect to the PC with 
PsiWin.

Each time you connect Psion machine to your PC using PsiWin you should log on as a New Owner. 
PsiWin keeps backed-up files, synchronization information, and details of opened files, in folders named 
after the Owner you specify when you first connect the machine. If you connect two machines and enter 
identical owner information for both, backup and synchronization details may be incorrect or misleading.

The only time you should choose the “Select Existing Owner” option, when you connect a new machine, 
is if you want to restore the contents of one machine to another.

PsiWin uses information relating to your machine to identify it when you connect it to the PC:
· If you connect a Series 5 machine, the machine is identified by a unique identification number built 

into the machine which cannot be changed or deleted.

Note: You only need to enter the owner name once for a Series 5, and even if you change the owner 
information the machine is still recognised by its identification number.

· If you connect a Series 3/3a/3c or Siena, the machine is identified by the owner information that you 
have entered in its System screen.

Note: If you change the owner information on a Series 3/3a/3c or Siena between connection sessions 
you’re prompted to select your owner name or enter a new name when you next connect.

It is important for PsiWin to distinguish between machines because you can:
· Choose to backup machines automatically, and PsiWin uses the machine’s Owner Name for its 

backup settings.

· Enter different settings for each machine. For example, you can select the file format to which you 
want to automatically convert any files you drag between each Series 5 and the PC.

See also: 

Understanding Psion machine and disk names

Using more than one Psion machine

Removing owner information with the Owner Manager
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Using more than one Psion machine

More than one person can use PsiWin to manage their Psion files on the same PC.

PsiWin detects when you:
· Attach a Psion for the first time.

When you first connect a Psion to the PC you need to enter an owner name.

· Change the owner details on a Series 3/3a/3c or Siena.

If you change the owner details on a Series 3/3a/3c or Siena you need to either select your name 
from the list of existing owners, or enter new owner details.

Each time you connect Psion machine to your PC using PsiWin you should log on as a New Owner. 
PsiWin keeps backed-up files, synchronization information, and details of opened files, in folders named 
after the Owner you specify when you first connect the machine. If you connect two machines and enter 
identical owner information for both, backup and synchronization details may be incorrect or misleading.

The only time you should choose the “Select Existing Owner” option, when you connect a new machine, 
is if you want to restore the contents of one machine to another.

Note: PsiWin identifies Series 5 machine machines by a unique built-in identification number, so you only 
need to enter owner details the first time you connect a Series 5 machine.

See also:

How to restore files and folders

Understanding Psion machine and disk names

Connecting to a new Psion machine
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Connecting to a new Psion machine

If PsiWin doesn't recognize the Psion that you have connected the New Psion dialog will be displayed.

To enter owner details:
1. Click on the Create New Owner radio button.

2. Click on the OK button.

3. Type your name in the “Welcome to PsiWin” dialog.

4. Click OK to confirm the new owner details.

You can now use PsiWin to browse and manage the files on the Psion.

If you select the “Select Existing Owner” option PsiWin may not be able to give correct information about 
backup dates, etc. It is therefore advisable to always create new owner details whenever connecting a 
Psion for the first time.

See also: 

Using more than one Psion machine

Changing owner details for a Psion machine
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Changing owner details for a Psion machine

If you have changed the owner details on a Series 3/3a/3c or Siena the New Psion dialog will be 
displayed the next time you connect the machine. You need to select a name from the list of existing 
owners, or alternatively create a new owner.

To select an existing owner:
1. Click the Select Existing Owner radio button.

2. Select your name from the list of owners.

3. Click OK to confirm the details.

To add a new owner:
1. Click the Add new Owner radio button.

2. Enter your name in the New Owner box.

3. Click OK to confirm the new details.

You can now use PsiWin to browse and manage the files on the Psion.

Note: Series 5 machines are identified by a unique built-in identification number, so you can change the 
owner details without re-entering your owner name in PsiWin.

See also: 

Using more than one Psion machine

Connecting to a new Psion machine
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Changing PsiWin’s owner options

You can change the standard owner options settings for the Psion machine at any time.

To change the owner options:
1. Connect the Psion to the PC.

Note: You need to connect the Psion before changing the owner options because more than one person 
can connect to the same PC. PsiWin uses your owner name to identify the machine you have connected 
and display its current owner options.

2. Right-click on the My Psion icon, or on the connection icon on the Taskbar, and point to Properties.

3. Click on the General tab in the Psion Properties dialog. This page displays your owner information 
and you can choose:

– The folder on the PC in which all the Psion files are kept by clicking the Browse button.

– Whether the Copy dialog is displayed when you are copying and converting files between the 
Series 5 and the PC by selecting or deselecting the Display choice of converters when copying
from PC to Psion check box.

4. Click the Apply button to confirm any changes without closing this dialog, or click the OK button to 
save any changes and close the dialog.

See also: 

Changing the Psion machine properties

Using more than one Psion machine
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Removing owner information with the Owner Manager

Each Psion machine that you connect to your PC using PsiWin is identified by its disk name, owner 
name, and/or internal serial number. If more than one person has connected their Psion machine to your 
PC you might, on occasion, like to tidy up the list of registered PsiWin owners and delete information 
relating to people who no longer connect to your PC.

Deleting an owner removes all information related to that person including backups and Synchronizer 
data.

To delete a registered owner:
1. Click the Start button, point to Programs, point to PsiWin 2.1 and click Owner Manager.

2. Click on one of the current owners.

To see more information about the owner and their machines, click View Details.

3. Click Delete This Owner to remove all information relating to the selected owner, or

Click Delete All Owners to remove all information relating to all owners.

See also:

Viewing and removing Psion machine information

Using more than one Psion machine

Changing owner details for a Psion machine
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Viewing and removing Psion machine information

You can use PsiWin to connect and manage as many different Psion machines as you like. If the same 
person connects more than one machine, you can review the details of each and, if necessary, delete 
machines which are no longer required.

Deleting a Psion machine removes all information related to that machine, including backups and 
Synchronizer data.

To view or delete a registered Psion machine:
1. Click the Start button, point to Programs, point to PsiWin 2.1 and click Owner Manager.

2. Click on the appropriate owner and click the View Details button.

3. Click the arrow next to the Supported machines box.

4. Select a machine from the drop-down list of all the machines which the selected owner has connected
using PsiWin.

PsiWin displays a summary of information about the selected machine.

5. If desired, click the Delete This Machine button to remove all information relating to the selected 
machine, or

Click Delete All Machines to remove all information relating to all machines.

6. Click OK to return to the Owner Manager.

See also:

Removing owner information with the Owner Manager

Using more than one Psion machine

Quick guide to PsiWin



Upgrading files to Series 5 format

Use the Upgrade to Series 5 program to convert and transfer files from your Series 3/3a/3c and Siena 
machine to your Series 5. The upgraded files are all transferred to a folder called S3 files on the Series 5. 

Alternatively, you can manually copy and convert individual files from your Series 3/3a/3c or Siena.

Note: The Upgrade to Series 5 program also upgrades any files on Solid State Disks (SSDs) that are 
inserted in the machine when you choose to upgrade. If you don’t want the files on SSDs to be upgraded, 
remove them before starting the Upgrade to Series 5 program.

The Upgrade to Series 5 program transfers and converts the following types of file from the Series 
3/3a/3c and Siena to the Series 5:

Word files
Sheet files
Agenda files
Data files
Record and Voice Notes files
Sketch files

You need to remove the password from any password-protected files, or memos in Agenda, before 
upgrading, otherwise the Upgrade will not be able to convert them correctly.

Note: Unlike the Series 3/3a/3c and Siena, the Series 5 does not distinguish files by file type or filename 
extension. If you had two files with the same name but created in different programs on the Series 3/3a/3c
or Siena, the Upgrade to Series 5 program will add a number to the file names so that you can distinguish
between them on the Series 5.

If you have any add-on applications on your Series 3/3a/3c or Siena the Upgrade to Series 5 program 
creates backup copies on the PC, but won’t copy them back to the Series 5 because you can’t use them 
on the Series 5.

Note: The Upgrade to Series 5 program will however convert any Data and Word files used by add-on 
applications, so you might find some files on your Series 5 which you don’t recognize after you’ve 
upgraded.

See also: 

How to upgrade to a Series 5

How to upgrade a single file to Series 5 format

Converting Series 3/3a/3c and Siena files

Converting files between different formats
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How to upgrade to a Series 5

The Upgrade to Series 5 program converts your Series 3/3a/3c and Siena files to Series 5 format and 
then transfers them to your Series 5.

Note: Password-protected files or Agenda memos won’t be upgraded. You need to remove their 
passwords on the Series 3/3a/3c or Siena before starting the upgrade for them to be upgraded.

If you’ve used PsiWin with your Series 5 before upgrading Series 3/3a/3c or Siena files to Series 5 format,
and have chosen to automatically backup your machine on the Backup tab of the Psion Properties dialog,
you will need to turn this option off before upgrading to Series 5.

To start the upgrade to Series 5:
1. Click the Start button on the Taskbar, point to Programs, point to PsiWin and then click on Upgrade 

to Series 5.

2. Connect the Series 3/3a/3c or Siena you want to upgrade, ensure that the link is turned on and click 
the Yes button in the Upgrade to Series 5 dialog to start the upgrade.

If this is the first time you’ve connected the Series 3/3a/3c or Siena, or if you’ve changed its owner 
details, the New Psion dialog is displayed.

Note: The cable supplied with PsiWin is designed for your Series 5. Other machines may require a 
different cable.

The files are copied to the PC and upgraded to Series 5 file formats, then the PsiWin Upgrade 
Connect dialog is displayed.

3. Disconnect the Series 3/3a/3c or Siena and ensure that its link is turned off.

4. Connect the Series 5, ensure the link is enabled correctly and click the OK button to start copying the 
files into a folder called S3 Files onto the Series 5.

Note: If this is the first time you’ve connected the Series 5 the New Psion dialog is displayed.

5. Click the OK button to exit the Upgrade to Series 5 program.

Some formatting in upgraded Word and Sheet files might have changed during the upgrade. Jotter files 
on the Series 3c are converted to Data files before transfer to the Series 5, since the Series 5 does not 
have a Jotter program.

Note: PsiWin identifies individual Series 3/3a/3c and Siena machines by the owner information which has 
been entered in the System screen. If no information has been set, PsiWin will not be able to differentiate 
between machines and the upgrade(s) will not be successful. Therefore, if you want to upgrade several 
machines (of the same, or different, types), you must make sure that each machine has different owner 
information. You must also ensure that you log in to PsiWin as a new owner each time a different machine
is connected.

See also:

How to upgrade a single file to Series 5 format

Upgrade problem

Converting Series 3/3a/3c and Siena files

Quick guide to PsiWin



How to upgrade to a Series 5 (footnote 1)

New Psion dialog
You can use the New Psion dialog to either:

· Create a new owner.

· Select an existing owner.

You need to enter an owner name for each Psion you connect to a PC because more than one owner can
connect their Psion to the same PC. PsiWin identifies which machine is connected by the owner name.



How to upgrade to a Series 5 (footnote 2)

New Psion machine dialog
You can use the New Psion dialog to either:

· Create a new owner.

· Select an existing owner.

You need to enter an owner name for each Psion you connect to a PC because more than one person 
can connect their Psion to the same PC. PsiWin identifies which machine is connected by the owner 
name.



How to upgrade a single file to Series 5 format

If you do not want to upgrade all the files on your Series 3/3a/3c or Siena machine, or if you add a new 
file to a Series 3/3a/3c/Siena and later want to upgrade it, you can upgrade a single file to Series 5 file 
format.

To upgrade a single file to Series 5 format:
1. Connect your Series 3/3a/3c or Siena to the PC and ensure that the link is correctly enabled.

2. Drag the file you want to upgrade to a temporary folder on the PC. The file is copied to the PC and the
Copy dialog is displayed.

3. Accept “Unknown” as the destination file format and click the Copy button.

4. Disconnect your Series 3/3a/3c, then connect your Series 5 to the PC and ensure that the link is 
turned on.

5. Hold down the left mouse button and drag the file to a folder on your Series 5. The Copy dialog is 
displayed.

6. Select the appropriate Series 5 file format from the Type drop-down list and click the Convert button. 
The file is converted and copied to the Series 5.

You can now open the file on your Series 5.

See also: 

Converting Series 3/3a/3c and Siena files

Upgrade problem

Upgrading files to Series 5 format
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Troubleshooting

The following error messages may be displayed during the Upgrade to Series 5 process.

Connection to the wrong machine

No Psion machine found

Psion machine not recognized

Upgrade problem

Upgrade not complete

No files upgraded

General upgrade error

Unrecognized files on your Series 5



Connection to the wrong machine

Message:
Your machine has connected to a Series 3/5, but PsiWin Upgrade was expecting to connect to a Series 
5/3.

Problem:
The wrong machine is connected - you have either connected a:

· Series 3/3a/3c or Siena instead of a Series 5, or

· Series 5 instead of a Series 3/3a/3c or Siena.

Suggestions:
· Disconnect the current machine and connect the correct machine, or

· If the two machines are both connected at the same time, to different COM ports, ensure that PsiWin 
is connecting to the correct COM port by checking the settings on the Communications tab of the 
Psion Properties dialog.

Note: To open the Psion Properties dialog click the Properties option on the menu displayed when you 
click the right mouse button on the My Psion icon.



Connection to the wrong machine (footnote 1)

COM port
Your PC uses COM (communications) ports, also known as Serial ports, to exchange information with 
other devices which may be connected to it such as a Psion, a modem, or a serial mouse. Each COM 
port on your PC has a different number, typically between 1-4.



No Psion machine found

Message:
PsiWin Upgrade’s connection to the Psion has been broken.

Problem:
The Upgrade to Series 5 machine program can’t locate a Series 5 to connect to.

Suggestions:
You need to check that the:

· Link on the Series 5 machine has been correctly enabled.

· Docking cable is connected to both the Series 5 and PC.

· Baud rate is set to the correct rate - you can change this using the Communications tab of the Psion 
Properties dialog.

When a Psion is connected to a COM port it automatically uses the maximum Baud rate that the 
connected Psion can use. If the Psion machine and PC are having difficulty communicating, you can 
lower the Baud rate on the Psion. If communication is still poor you can manually set a matching 
Baud rate for PsiWin, thereby disabling the Maximum attainable option.

Note: To open the Psion Properties dialog click the Properties option on the menu displayed when you 
click the right mouse button on the My Psion icon.



No Psion machine found (footnote 1)

Baud Rate
The speed at which electronic information travels, typically between two computers or between a 
computer and a printer, measured in bps (bits per second).

· Series 5 machines can communicate at Baud rates of up to 115200 bps.



Psion machine not recognized

Message:
The Psion you have connected to the PC has not been recognized.

Problem:
You have tried to connect a Psion machine which won’t work with the Upgrade to Series 5 program.

Suggestion:
Ensure that the machine you’re trying to upgrade is compatible with the Upgrade to Series 5 program. 
You can upgrade files from these machines:

· Series 3

· Series 3a

· Series 3c

· Siena



Upgrade problem

Message:
A problem with the Upgrade application has occurred.

Suggestion:
You need to uninstall and re-install PsiWin, then run the Upgrade to Series 5 program again. See How to 
uninstall PsiWin



Upgrade not complete

Message:
PsiWin Upgrade has been stopped before it could finish upgrading your files.

Problem:
You clicked on the Stop button during the upgrade process.

Suggestion:
Click the OK button and restart the Upgrade to Series 5 program, by clicking the Start button on the 
Taskbar, pointing to Programs, pointing to PsiWin and clicking on Upgrade to Series 5.



No files upgraded

Message:
PsiWin Upgrade has been unable to find any files to upgrade.

Problem:
The Upgrade program analyzed the files on your Series 3/3a/3c or Siena, but couldn’t find any files which 
can be upgraded to Series 5.

Suggestion:
The Upgrade to Series 5 program can upgrade these file types:

· Word

· Sheet

· Agenda

· Data

· Jotter

Note: PsiWin converts Series 3c Jotter files to Data files on your Series 5.

If you have password protected any of the above file types on your Series 3/3a/3c or Siena they won’t be 
upgraded. Remove all passwords from your Series 3/3a/3c or Siena files before upgrading.



General upgrade error

Message:
A general error has occurred in the Upgrade application. Error number n.

Problem:
The Upgrade to Series 5 program was unable to locate one of the files needed to complete the upgrade 
process.

Suggestion:
You need to uninstall PsiWin, then re-install PsiWin to restore the missing file. See How to uninstall 
PsiWin



Unrecognized files on your Series 5

Problem:

As a result of the Upgrade to Series 5, you might find that some Data and Word files which you don’t 
recognise in the Series 3 Files folder on your Series 5.

This is because the Upgrade to Series 5 program copies Data and Word files used by the Series 3/3a/3c 
or Siena add-on applications over to your Series 5, but doesn’t copy the applications themselves because
they can’t be used on your Series 5.

Suggestion:
You can delete files you don’t recognize from your Series 5.

Tip: You can check the names of files that you think are used by add-on applications by looking inside the 
folder for the add-on application in the \apps directory on the appropriate disk on the Series 3/3a/3c or 
Siena.



Backing up and restoring files

Your Psion stores information very safely and securely, but it is not immune to damage, battery failure, 
and accidental deletion of files. PsiWin provides a simple but powerful backup procedure to ensure that 
your valuable Psion data remains safe.

Psion information that has been backed up to a PC, particularly if it is stored on a network, may be 
vulnerable to other users accessing it. You might prefer to keep your backups on a disk to which only you 
have access. See Changing PsiWin’s owner options for information on changing backup locations.

· You can set up PsiWin to back up the Psion automatically, at regular intervals, to minimize data loss. 
After the first full backup of a Psion machine, all future backups are incremental to make them as fast 
as possible.

Backing up also creates Archive folders which can contain up to six previous versions of your files 
(including any which have been deleted or modified since the last backup), in case you ever need to refer 
back to an earlier version of a file.

· You can also back up more than one Psion machine.

· You can choose where the backup is stored, even on a network drive.

See also: 

Backing up a Psion machine

Setting backup options

Backing up more than one Psion to a PC

How to restore files and folders
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Backing up and restoring files (footnote 1)

Incremental Backup
An incremental backup copies only those files which have changed since the last time you backed up 
your Psion, making backups far quicker.



Backing up and restoring files (footnote 2)

Archive
PsiWin keeps up to six previous copies of backed-up files in File Archives folders. Should you ever need 
to restore an earlier version of a file to the Psion, simply drag and drop it from the Archive folder to the 
Psion.



Backing up a Psion machine

When you start a backup, PsiWin checks to see if you have previously backed up any of the currently 
selected disks.

Note: When you connect a Psion machine for the first time, PsiWin asks for owner details in order to 
identify it in future.

If this is the first time you have backed up the Psion, PsiWin performs a full backup, copying all the files 
on the Psion to a new folder on the PC. Subsequent backups of the same machine are always 
incremental and therefore much quicker.

To start a backup:
1. Ensure that the Psion is connected to the PC, the link is on, and the Link connection options are set 

correctly.

2. Right-click on the My Psion icon and click Backup.

PsiWin displays the Psion Backup dialog.

3. Place a tick next to the disk(s) you want to back up.

4. Click the Backup button to start the backup.

PsiWin will close any open files or programs on the Psion, analyze differences between files on the 
selected disk and the previously backed up version of that disk (if applicable), then begin the backup 
procedure and inform you when it is completed.

See also: 

Backing up a Psion machine

Backing up selected files and folders

Keeping archives (older versions of files)

Backing up more than one Psion to a PC

How to restore files and folders

Automatic backup

Quick guide to PsiWin



Backing up a Psion machine (footnote 1)

Incremental Backup
An incremental backup copies only those files which have changed since the last time you backed up 
your Psion, making backups far quicker.



Hidden and system files

Backup and Restore operations apply to all files, whatever their attributes. Hidden files are also backed 
up and restored without changing their attributes.

Backup and restore also stores information about the current system settings on the Psion machine 
including:

· Owner information.

· Home city.

· System screen preferences.

· System passwords.

Note: Individual file passwords are also kept intact.

See also: 

Backing up and restoring files
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Hidden and system files (footnote 1)

Hidden files
Some files and folders on the Series 5, including the System folder and any files you may have hidden 
yourself, are not visible from the System screen on the Series 5.



Backing up more than one Psion to a PC

You can back up more than one Psion machine to the PC using PsiWin. PsiWin automatically checks 
which Psion is connected and ensures that it is backed up to its individual location. Backup, archive and 
synchronization data for one machine will not interfere with that of another.

Note: If you intend to use PsiWin to back up Series 3/3a/3c or Siena machines you will need to ensure 
that each machine has different owner information, and that all disks have unique names.

See also: 

Connecting to a new Psion machine

Understanding Psion machine and disk names

Backing up and restoring files
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Backing up more than one Psion to a PC (footnote 1)

Synchronization
PsiWin can keep the Series 5 Agenda files up to date with Lotus Organizer, Microsoft Schedule+, or 
Microsoft Outlook files on your PC. When you connect, the files are compared with each other and any 
changes - additions, deletions, etc., - are reflected in both programs.



Backing up selected files and folders

If you don't want to back up all the files on the Psion you can select individual files, folders or disks to 
back up.

To back up a single file or folder:
1. Connect the Psion machine to the PC.

2. Open Windows Explorer.

3. Double-click the My Psion icon.

PsiWin will attempt to connect to the Psion, then display the contents of its disks.

4. Right-click on the file or folder you want to back up and click Backup.

To back up a single disk:
1. Connect the Psion machine to the PC.

2. Open Windows Explorer.

3. Click next to the My Psion icon in the left-hand pane.

4. Right-click on the disk you want to restore and click Backup.

See also: 

Backing up a Psion machine

How to restore files and folders
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Setting backup options

You can choose which Psion disks to back up, how many file versions to keep, and where to store them, 
by clicking on the Options button in the Backup dialog.

You can change the Backup options at any other time by right-clicking on the My Psion icon, clicking 
Properties and selecting the Backup tab.

To choose which Psion disks to back up:
· Place a tick in the box next to the names of the relevant disks.

To change the number of old versions of files to keep in the archive folders:
· Select a number (between one and six) from the drop-down box.

Tip: If you will always want to back up the same disk(s) to the same locations, check the Always use 
these settings. Don’t show Backup dialog box. If you later want to change this setting, you can 
deselect this option.

To change the folder where PsiWin keeps your backed up Psion files:
1. Select the General tab.

The Current folder for Psion files is indicated.

2. Click the Browse button to select a new folder.

See also: 

Backing up and restoring files

Automatic backup
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Setting backup options (footnote 1)

Archive
PsiWin keeps up to six previous copies of backed-up files in File Archives folders. Should you ever need 
to restore an earlier version of a file to the Psion, simply drag and drop it from the Archive folder to the 
Psion.



Automatic backup

You can set PsiWin to automatically back up your Psion machine at regular intervals (when connected), 
and set how often you want this to happen. Automatic backups are performed minimized.

To back up the Psion machine automatically:
1. Right-click the My Psion icon and click Properties.

2. Select the Backup tab.

Your Psion disks are listed in the Psion Disk To Back Up column.

3. Place a tick in the box next to each disk that you want to automatically back up.

4. Place a tick in the Perform automatic backup box to enable the radio buttons.

5. Select from the radio buttons to back up:

– Each time connection is made.

– Once per day, the first time you connect.

– Once per week, the first time you connect.

If you have not ticked the Perform automatic backup box, the radio buttons will remain dimmed.

6. Press Apply to save your options, or OK to save and close the dialog.

Tip: If you normally power the Series 5 machine with a mains adapter when you are connected to a PC, 
you can set the Automatic switch-off to "If no external power".

See also: 

Backing up and restoring files

Keeping archives (older versions of files)
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Automatic backup (footnote 1)

Minimized
While an automatic backup is in progress it appears as an icon on the Taskbar and the Backup Progress 
dialog is not displayed on the PC.



Automatic backup (footnote 2)

Radio buttons
Appear beside a list of items when you can only select one option at a time.

The selected option appears filled in.



How to restore files and folders

Should you accidentally delete a file or folder, you can restore the most recently backed-up version, or an 
earlier version (if you have chosen to keep archived versions of files).

To restore files or folders:
1. In Windows Explorer, click the My Psion icon

2. Double-click the Backup folder.

3. Right-click on the file, folder or disk you want to restore and click Restore.

To restore multiple files or folders:
1. In Windows Explorer, click the My Psion icon.

2. Double-click the Backup folder.

3. While holding down the Ctrl key, left-click on the files or folders you want to restore.

4. Right-click any of the highlighted files or folders and click Restore.

· You can also restore files by dragging them from the PC backup folder to the Psion machine while 
holding down the Shift key.

In the unlikely event of you needing to reset the Psion machine, or if you've lost your data for any other 
reason, you can restore the entire disk by the same method.

When you select the Restore command, the Psion Restore dialog opens.

In the Psion Restore dialog you can set the following options:
· The PC folder which contains the file set you want to restore.

· The file set(s) in the current PC folder that you want to restore.

· The backed-up Psion disk that you want to restore from.

· Whether to format the Psion disk before restoring the files.

You should not format the Psion disk if it contains any files you want to keep. Formatting deletes all the 
information on a disk.

See also: 

Backing up and restoring files

Understanding Psion machine and disk names

Formatting a Psion disk
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Restoring an entire Psion disk

If you should ever lose all the information on a Psion (i.e. through battery failure or a hard reset), you can 
restore the entire contents of a Psion machine or disk.

You can also restore information that’s been backed up from one Psion machine on to another machine 
(i.e. if you want to share your files with somebody else, or if you lose your Psion and have to replace it).

To restore an entire Psion disk:
1. Right-click the My Psion icon and click Restore.

2. Place a tick next to the disk(s) you want to restore.

3. Click the Restore button to begin the restore process.

You can also choose to reformat the disk before restoring.

When you restore files from one Series 5 machine to a different Series 5 machine, PsiWin detects the 
different serial number. When the New Owner dialog is displayed, select Existing Owner to proceed.

Note: If you should ever forget the system password for the Series 5 machine, first perform a hard reset of
the Series 5. Then delete the file named System.ini in your PC Backup \system\ folder (this file contains 
your system password and owner information) and finally perform a full restore of the Series 5 machine C:
disk.

See also: 

Backing up and restoring files

Restoring missing files

Formatting a Psion disk
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Restoring an entire Psion disk (footnote 1)

Formatting
Formatting removes all the files and folders stored on a disk. This operation cannot be undone.



Formatting a Psion disk

Before restoring the entire contents of a Psion disk you can format the disk to remove all the information, 
files and folders stored on it. This can help fix problems which may occur with the disk if it has become 
corrupted.

To format and restore a Psion disk:
1. Right-click on the My Psion icon and click Restore.

2. Place a tick next to the disk(s) you want to restore.

3. Place a tick in the box marked Format Disk Before Restore.

4. Press the Restore button to begin, or Cancel to abandon.

Formatting a disk removes all information from it and cannot be undone.

You can also format a Psion disk from within Windows Explorer.

To format a Psion disk from the Explorer view:
1. Open Windows Explorer.

2. In the left-hand pane, click on the My Psion icon..

3. In the right-hand pane, right-click the disk you want to format and point to Format....

4. Press Yes to format the disk or No to abandon.

Formatting a disk removes all information from it and cannot be undone.

See also: 

Understanding Psion machine and disk names

How to restore files and folders
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Restoring missing files

If one of the files required to backup your Psion machine is deleted from the Psion, PsiWin restores the 
file when you next connect the Psion machine.

If a backup record is missing the Psion connected dialog is displayed.

Note: This dialog is only displayed if you’ve already backed up the Psion machine.

You can click:
· Yes to display the Psion Restore dialog, and restore all the previously backed up files along with the 

missing back up record to your Psion machine.

· No to restore just the missing backup record.

Note: The date when you last backed up your files to the PC is shown on this dialog.

See also: 

Backing up and restoring files

Quick guide to PsiWin



Keeping archives (older versions of files)

The Backup folder contains an exact copy of all the files on the Psion as they were when the backup was 
performed.

Any files which have been changed (or deleted) since the previous backup are moved to a folder called 
Archive 1. If a file changes again before the next backup, the first version will be moved (during the 
backup) from the Archive 1 folder to a folder called Archive 2, and the more recently backed-up version 
will be put in the Archive 1 folder. Up to six versions of changes can be kept.

Note: Deleted files are not moved from the Archive folder by subsequent backups. If you regularly delete 
files after backing up, these deleted files will accumulate in the Archive 1 folder and you might like to 
clean them out periodically.

If you should ever need to restore an older version of a file, or one which has since been deleted from the 
Psion, you may be able to retrieve it from one of the Archive folders in Windows Explorer.

· If you have not backed up the Psion since deleting a file, it will be in the Backup folder.

To restore an older version of a file:
1. Highlight the file in the relevant Archive folder.

2. To restore the file to the same folder that it was in when modified or deleted, right-click on it and click 
Restore.

PsiWin recreates any necessary folders to ensure that the file location is as it was when modified or 
deleted.

· To restore a file to a different location, drag it from the Archive folder to the folder you want on the 
Psion machine.

To change the number of previous versions of files kept in Archives:
1. Right-click on the My Psion icon and click Properties.

2. Select the Backup tab.

3. In the Archive options section, set the Number of File Versions To Archive to a number between 1 
and 6.

Psion information that has been archived to a PC, particularly if it is stored on a network, may be 
vulnerable to other users accessing it. You might prefer to keep your backups and archives on a disk to 
which only you have access. See Changing PsiWin’s owner options for information on specifying a 
backup folder.

See also: 

Backing up a Psion machine

How to restore files and folders
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General problems and suggestions

· If PsiWin cannot connect to the Psion machine, try selecting a slower Baud rate on the Psion.

· If, during a Backup process, PsiWin finds two disks with the same name, you will be asked to rename 
one of them before backing up.

· If the name on the Psion does not match the owner name of a backup file set, PsiWin will ask you to 
select an existing owner name or enter a new owner name before continuing backup.

See also: 

Understanding Psion machine and disk names

Setting Connections options
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General problems and suggestions (footnote 1)

Baud Rate
The speed at which electronic information travels, typically between two computers or between a 
computer and a printer, measured in bps (bits per second).

· Series 5 machines can communicate at Baud rates of up to 115200 bps.



Understanding Psion machine and disk names

PsiWin can automatically identify different Psion machines and disks.

· Series 5 machines have a built-in serial number which cannot be changed and enables PsiWin to 
identify individual machines. PsiWin will therefore be able to identify a machine, even after a hard 
reset, and restore the correct file set.

· Series 3 and Siena machines are identified by the owner information that is entered in the system 
screen.

· Internal and Memory Disks are identified by the names that have been set for them in the system 
screen.

Note: Each Psion disk name must be unique. If you have two disks with the same name, or a disk without 
a name, you must rename one of them from the system screen before you can back them up.

See also: 

Using more than one Psion machine

Quick guide to PsiWin



Synchronizing Psion and PC files

You can use PsiWin's Synchronizer to co-ordinate your Series 5 Agenda and address book with those in 
your PC scheduler.

If you are using a PC scheduler with Groupware support on a network, other people will have access to 
your PC agenda and will be able to add and view entries. PsiWin's Synchronizer will keep your Series 5 
Agenda up to date with your PC scheduler (including any entries which may have been entered by 
someone else) and inform you of any clashing or overlapping entries.

· PsiWin can synchronize with Microsoft Schedule+ 7 and 7a, Lotus Organizer 2.1 and 97, and 
Microsoft Outlook 97 formats.

Note: Microsoft Internet Explorer 4 includes a special “cut-down” version of Outlook called Outlook 
Express. Outlook Express does not have the full time-management features of Outlook 97 and you 
cannot synchronize your Series 5 Agenda with it.

You can synchronize a single Series 5 Agenda or Address book with:
· A single PC scheduler on a single PC.

· A single PC scheduler installed on a network.

· Multiple PC schedulers on different PCs (e.g. at home and at work). These might be the same type of 
scheduler, or different ones.

You can synchronize a number of different Series 5 Agenda or Address book files with:
· A network installation of a PC scheduler (e.g. several employees could synchronize their work 

Agendas with the same master scheduler).

· A single PC scheduler on a single PC (e.g. you may have two different Agenda files on your Series 5 
which you want to keep separate).

· Multiple PC schedulers on different PCs (e.g. you may have a work Agenda synchronizing with a 
network installation of Organizer at the office, and a personal Agenda synchronizing with Schedule+ 
on your PC at home).

Each time you specify a new Series 5 Agenda or Address book to synchronize with a PC scheduler you 
need to set up a new synchronization task which stores details of the file types, names and locations, 
any passwords and network logon scripts, and the date when the files were last synchronized.

The Synchronizer wizard helps you set up as many different synchronization tasks as you need on your 
PC.

Wherever your PC Agendas are stored, the process of setting up the synchronization is the same. Once a
synchronization task has been set up you need only double-click the relevant icon to start the 
synchronization process.

· You can also choose, during setup, to create a Desktop shortcut to a Synchronizer task. If you do 
create a shortcut, simply double-clicking on the icon will start the synchronization. 

Do not attempt to disconnect your Series 5 during a synchronization, otherwise information may be lost. If
you have enabled the “Auto switch off” feature on your Series 5 you should either disable it temporarily 
during a synchronization, or else increase the “Switch off after” setting so that sufficient time is allowed for
the synchronization to complete before auto switch-off.

See also:

Creating and reviewing Synchronizer tasks

Synchronizing Address books

Selecting your PC scheduler



Setting up a synchronization with the wizard

Synchronizing Series 5 and PC files

Automatic synchronization

Creating a Desktop shortcut to a Synchronizer task

Quick guide to PsiWin



Creating and reviewing Synchronizer tasks

Before you can synchronize a Series 5 Agenda or Address book with a PC scheduler you must create a 
new “Synchronizer task”. A Synchronizer task contains details of the Series 5 and PC Agendas and 
address books which are used in the synchronization, together with any special information relating to the
files concerned. Once you have set up a Synchronizer task the details are stored on your PC and you can
quickly and easily update all Synchronizer tasks for any Series 5.

You can have as many Synchronizer tasks as you like, each one containing details of a particular pair of 
agendas to synchronize. However only those tasks relating to the currently connected Series 5 appear in 
the main Synchronizer window.

To create a new Synchronizer task:
Either:

1. Double-click the Synchronize Psion icon on the desktop, then

2. Click the New button to start the wizard.

Or:

1. Double-click the My Psion on the Desktop.

2. Double-click the Synchronization Control Panel icon.

3. Click the File menu and point to New-Synchronization, or

Right-click anywhere in the window and select New-synchronization.

To view or change settings for an existing Synchronizer task:
1. Double-click the My Psion on the Desktop.

2. Double-click the Synchronization Control Panel icon.

3. Right-click on the appropriate task and point to Properties.

See also:

Synchronizing Psion and PC files

The Psion Synchronizer window
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The Psion Synchronizer window

You can check, modify, start and delete synchronizations, as well as creating new synchronization tasks, 
in the Psion Synchronizer window.

To open the Psion Synchronizer window:
· Double-click the Synchronize Psion icon on the Desktop.

To check or modify the settings for an existing task:
1. Highlight the desired task in the Psion Synchronizer window.

2. Click the Properties button.

3. Modify the settings, as desired, referring to Changing Synchronizer task settings.

To delete or rename an existing task:
· Click the Delete or Rename button, as appropriate.

To start an existing synchronization:
1. Check the box(es) next to the task(s) you want to start.

2. Click the Synchronize button.

To create a new synchronization task:
· Click the New button.

If you are sure that you will always want to update the same synchronization tasks for the current 
machine, you can select Always use these settings. Don’t show this dialog again. In future, double-
clicking the Psion Synchronizer icon on the Desktop will automatically update all the selected tasks for the
currently connected machine (if you later need to re-enable this option, see Changing Synchronizer task 
settings).

See also:

Synchronizing Psion and PC files

Setting up a synchronization with the wizard
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Setting up a synchronization with the wizard

The synchronization wizard helps you set up your Synchronizer tasks. It leads you through a series of 
Properties pages on which you can specify the Agenda files to use, the types of entries and date range to 
include, and other options.

If you want to change these settings later, right-click on the appropriate task icon and click Properties.

To start the Synchronization wizard:
1. Connect your Series 5 to the PC and double-click the Synchronize Psion icon on the Desktop.

If this is the first time you have created a task the Synchronizer window will be empty.

2. Click the New button.

3. Enter the required information on each of the Properties pages which follow and click Next to continue
or Back to return to a previous page.

The following sections describe how to change the settings on each of the pages.

Note: Please refer also to the online Help included with Lotus Organizer, Microsoft Schedule+, Microsoft 
Outlook and Microsoft Exchange.

See also:

Selecting your PC scheduler

Synchronizing Psion and PC files

Synchronizing Series 5 and PC files

Automatic synchronization

Deleting a newly-created PC Scheduler file
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Selecting your PC scheduler

When you set up a new synchronization using the synchronization wizard, the first thing you must do is 
pick a PC scheduler to synchronize with (PsiWin can synchronize with Lotus Organizer, Microsoft 
Schedule, and Microsoft Outlook). Select one of these from the drop-down list of PC applications and 
click OK to continue.

Tip: If you will always be synchronizing with the same PC Scheduler you can tick “Always use this 
application. Don’t show this dialog again”, in which case you will not be asked to select a PC application 
the next time you set up a synchronization. If you do select this option and later want to use a different PC
scheduler, see “Adding and removing support for a PC scheduler”.

· If you are setting up a synchronization with Organizer, go to Selecting which Series 5 files and 
Organizer agendas to synchronize.

· If you are setting up a synchronization with Schedule+, go to Selecting which Series 5 files and 
Schedule+ agendas to synchronize.

· If you are setting up a synchronization with Outlook, go to Selecting which Series 5 files and Outlook 
agendas to synchronize.

Microsoft Internet Explorer 4 includes a special “cut-down” version of Outlook called Outlook Express. 
Outlook Express does not have the full time-management features of Outlook and you cannot 
synchronize your Series 5 Agenda with it.

See also:

Setting general Synchronizer options

Synchronizing Psion and PC files
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Synchronizing a Series 5 Agenda with Lotus Organizer

If you have Lotus Organizer on your PC you can synchronize your Series 5 Agenda and address book 
with the appropriate sections in Organizer.

Do not attempt to disconnect your Series 5 during a synchronization, otherwise information may be lost. If
you have enabled the “Auto switch off” feature on your Series 5 you should either disable it temporarily 
during a synchronization, or else increase the “Switch off after” setting so that sufficient time is allowed for
the synchronization to complete before auto switch-off.

See also

Selecting which Series 5 files and Organizer agendas to synchronize

Preparing an Organizer file for synchronization

Troubleshooting Organizer problems 
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Selecting which Series 5 files and Organizer agendas to synchronize

You can synchronize your Series 5 Agenda, your Series 5 Address book, or both, with Lotus Organizer. In
order to do so you must specify, on the Applications Properties page, which files you want to use.

To include your Series 5 Agenda in the synchronization:
1. Select Synchronize My Agenda.

2. Click the  button and browse for the Series 5 Agenda file you want to use (if it is different from C:\
Documents\Agenda).

To include your Series 5 Addresses in the synchronization:
1. Select Synchronize My Contacts.

2. Click the  button and browse for the Series 5 Data file you want to use (if it is different from C:\
Documents\Data).

Synchronizing with Single PC or Network installations of Organizer
Lotus Organizer can be set up in a number of different ways, depending on whether or not it is used over 
a network and on how users are identified. You must select one of the four possible “scheduling 
environments” and specify information for each in order to configure the synchronizer to work with your 
particular setup of Organizer.

· Select Local if you have Organizer installed on a single machine which is not connected to a network,
or if you are connected to a network but do not share your PC Agenda with other users. This option 
works directly with Organizer files and does not support any group scheduling features.

If you select Local you must specify the name and location (on the PC) of the Organizer file you want 
to synchronize with (click the Browse button  if the suggested file is incorrect).

· Select Single server if you are using a group scheduling version of Organizer which is installed on a 
network and uses your network logon ID to access files.

If you select Single server you must specify the name and location (on the PC) of the Organizer file 
you want to synchronize with (click the Browse button  if the suggested file is incorrect). You must 
also enter your network name and password on the Account tab.

· Select Notes if you are using a group scheduling version of Organizer which is installed on a network 
and uses your Lotus Notes account name to access files.

If you select Notes you must specify the name and location (on the PC) of the Organizer file you want
to synchronize with (click the Browse button  if the suggested file is incorrect). You must also enter 
your Lotus Notes account name and password on the Account tab.

· Select cc:Mail if you are using a group scheduling version of Organizer which is installed on a 
network and uses your cc:Mail account name to access files.

If you select cc:Mail you must specify the name and location (on the PC) of the Organizer file you 
want to synchronize with (click the Browse button  if the suggested file is incorrect). You must also 
enter your cc:Mail name and password on the Account tab and the path of the cc:Mail post office on 
the Post Office tab.

Note: If you are using a group scheduling version of Organizer and do not know your File name, Account 
name, Post Office, or other information, contact your network administrator for details.

Click Next to continue.

See also:

Synchronizing Psion and PC files

Choosing which entry types to synchronize with Organizer



About Organizer Sections

Synchronizing a Series 5 Agenda with Lotus Organizer
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Choosing which entry types to synchronize with Organizer

Your Series 5 Agenda can contain several different types of entry. You can choose to include or exclude 
any of them from the synchronization, and specify which Organizer Section to copy entry types to and 
from, on the Entry Types Properties page. You can choose to synchronize:

· Day entries

· Anniversaries

· Events

· To-Do entries

Note: All To-Do lists will be combined into a single Section of Organizer To-dos, and will then be 
grouped within that Section by category. Your Agenda To-dos will therefore remain discretely 
arranged.

· Contacts (only available if you have selected the “Synchronize my Contacts” option on the 
Applications Properties page).

For further information, please see About Organizer Sections

To include or exclude entry types from a synchronization:
1. Place a tick in the box(es) next to each of the entry types you want to include in the synchronization.

2. If you want to use other than the suggested Organizer sections, type a new name in the dialogs.

3. If you are including your Contacts in the synchronization and want to use other than the standard 
Organizer section (“Address”), type a new name in the Contacts to synchronize dialog.

Click Next to continue.

See also:

Synchronizing Psion and PC files

Synchronizing a Series 5 Agenda with Lotus Organizer

Selecting a date range to synchronize with Organizer
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About Organizer Sections

Organizer stores your information classified into “sections”, and each Series 5 entry type must be 
assigned a section to synchronize with.

· Day Entries, Anniversaries, Events and to-do's are automatically set up to Synchronize with Calendar,
Anniversary, Planner and To-Do. If you are happy with these settings you do not need to change 
them.

Note: If you choose to synchronize a Series 5 entry type with a particular Organizer Section, then 
subsequently change the Section you want to synchronize with, all previously-synchronized entries will 
remain in the old Section, effectively orphaned until you manually edit them yourself or re-synchronize 
with that Section.

See also:

Synchronizing a Series 5 Agenda with Lotus Organizer

Selecting which Series 5 files and Organizer agendas to synchronize

Choosing which entry types to synchronize with Organizer
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Selecting a date range to synchronize with Organizer

To specify a start date for the synchronization
In the Synchronize entries section of the Psion to PC Properties page, enter a number of days, weeks, 
or months in the From: boxes. All entries within the specified range will be synchronized.

All current and future entries in your Agenda are automatically included when you synchronize, but entries
which are older than the specified start date are excluded. The suggested setting is to synchronize entries
from 3 months in the past, but you might like to change this.

For example:

· If you use an Agenda file mainly as a planner for future events you could set this to 1 week in the 
past.

· If you have an Agenda file which you have been using for some time (e.g. which you have upgraded 
from a previous Psion machine), and in which you keep a record of things done, you could set this to 
10 years in the past, just the first time you synchronize, in order to include all your existing entries.

When choosing a date, bear in mind:

· How often you synchronize the agenda. If you do not synchronize very often, you might like to 
increase the setting in order to avoid losing “orphaned” entries.

· How often you change entries in the “past”. If you rarely change entries which are in the past, you 
don’t need to check them each time you synchronize.

· How many items you have in your agenda. If you have a very large Agenda file which you 
synchronize frequently, you may find that the Synchronizer task is taking a long time, so you may 
wish to reduce the size of the date range (or exclude certain entry types).

See also:

Synchronizing a Series 5 Agenda with Lotus Organizer

Synchronizing private and work entries with Organizer
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Synchronizing private and work entries with Organizer

When you set up a Synchronizer task you need to specify your “Work Days and Hours”. Entries outside 
these times will be marked as “private” in Organizer and will not be visible to anyone else who has access
to your Organizer agenda - e.g. over a network. This is useful if you have both personal and work-related 
information in your Series 5 Agenda.

However you may prefer to exclude private entries entirely or, if no-one else can access your Organizer 
agenda, you can include all entries regardless of their time.

To define Work Days and Hours:
1. On the Psion to PC Properties page, click the Change button.

2. Place a tick next to the days you want to treat as Work Days.

3. Enter start and finish times for your Work Hours.

To select which entries to synchronize:
On the Psion to PC Properties page, select from the following:

· All specified entries. If you select this option, all the Psion entry types you specified on the Entry types
page (see above) will be synchronized, regardless of the time set for the entry.

· All specified entries, but make entries outside work hours private. Entries outside your normal work 
hours set in PsiWin will be synchronized with the PC but will be set to “Private” in Organizer.

· Only entries within your work hours. Entries outside your specified Work Hours will not be 
synchronized.

Click Next to continue.

See also:

Synchronizing a Series 5 Agenda with Lotus Organizer

Preparing an Organizer file for synchronization
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Preparing an Organizer file for synchronization

You cannot synchronize with an Organizer file until it has been "initialized". To do this you must close the 
Organizer file after creating it (saving it will not achieve the desired result). Having once closed a file it can
be reopened, and may remain open during synchronization.

If you want to be able to synchronize with an Organizer file while it is open you must ensure that you have
checked the "multi user" option when saving it.

Please see Organizer on-line Help for further information about using Lotus Organizer.

See also:

Synchronizing a Series 5 Agenda with Lotus Organizer

Troubleshooting Organizer problems 
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Starting your new synchronization with Organizer

When you have finished setting up your new synchronization you can either synchronize your agendas 
right away, or you can save your settings and synchronize later. You can also create a shortcut to the new
Synchronizer task on your Desktop.

To synchronize agendas:
· Click the Synchronize button.

To save settings and synchronize later:
· Click the Finish button and then close the dialog.

To create a shortcut on your Desktop:
· Select “Create a shortcut on my Desktop”.

Double-click this icon to synchronize the associated agendas.

Do not attempt to disconnect your Series 5 during a synchronization, otherwise information may be lost. If
you have enabled the “Auto switch off” feature on your Series 5 you should either disable it temporarily 
during a synchronization, or else increase the “Switch off after” setting so that sufficient time is allowed for
the synchronization to complete before auto switch-off.

See also:

Synchronizing a Series 5 Agenda with Lotus Organizer

Synchronizing Series 5 and PC files

Creating a Desktop shortcut to a Synchronizer task
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Troubleshooting Organizer problems 

You can use PsiWin to synchronize your Series 5 Agenda with Lotus Organizer versions 2.1 and 97.

If you receive the error message “Unable to initialize API” when you attempt to synchronize with 
Organizer it is possible that you have an early version of Organizer 2.1, in which case you will need to 
install the upgrade included on the PsiWin CD-ROM.

Note: if you have installed PsiWin from floppy disks, or if you do not have access to the CD-ROM, the 
upgrade files are also available for download from the Psion site on the World Wide Web at 
http://www.psion.com
To check the version number of Organizer:
1. Open Windows Explorer.

2. On the View menu, click Options and select the Show all files option.

3. Open the folder where you installed Organizer.

If you did not specify a different folder during installation, this will be C:\Org2\

4. Locate the file named Tzportdb.dll.

5. Right-click on this file to display the menu and click Properties.

6. On the Version tab, check the Version number.

If the number is 2.10.75.3 then you need to install the upgrade from the CD-ROM.

To install the upgrade:
1. In the Organizer folder in Windows Explorer, rename the file Tzportdb.dll to Tzportdb.old.

2. Insert the PsiWin CD-ROM into your CD-ROM drive.

3. Browse to the folder \Extras\Org_up.

4. Copy the file Tzportdb.dll to your Organizer folder.

5. In the Organizer folder, right-click on the file Tzxport.dll and click Properties.

6. On the Version tab, check the Version number.

7. If the version number is 2.10.77.0, exit Explorer and reboot your machine.

If the version number is less than 2.10.77.0 check the description. If the description is NOT Lotus 
Organizer Transport Layer for Notes, exit Explorer and reboot your machine. If the description IS 
Lotus Organizer Transport Layer for Notes, continue as follows:

8. In the Organizer folder, rename the file Tzxport.dll to Tzxport.old.

9. Browse to the \Extras\Org_up folder on the PsiWin CD-ROM.

10. Copy the file Tzxport.dll to your Organizer folder.

11. Exit Explorer and reboot your machine.

See also:

Synchronizing a Series 5 Agenda with Lotus Organizer

Preparing an Organizer file for synchronization
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Synchronizing a Series 5 Agenda with Microsoft Schedule+

If you have Microsoft Schedule+ on your PC you can synchronize your Series 5 Agenda and address 
book with the appropriate folders in Schedule+

Do not attempt to disconnect your Series 5 during a synchronization, otherwise information may be lost. If
you have enabled the “Auto switch off” feature on your Series 5 you should either disable it temporarily 
during a synchronization, or else increase the “Switch off after” setting so that sufficient time is allowed for
the synchronization to complete before auto switch-off.

See also: 

Selecting which Series 5 files and Schedule+ agendas to synchronize

Selecting your PC scheduler
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Selecting which Series 5 files and Schedule+ agendas to synchronize

You can synchronize your Series 5 Agenda, your Series 5 Address book, or both, with Schedule+. In 
order to do so you must specify, on the Applications Properties page, which files you want to use.

To include your Series 5 Agenda in the synchronization:
1. Select Synchronize My Agenda.

2. Click the  button and browse for the Series 5 Agenda file you want to use (if it is different from C:\
Documents\Agenda).

To include your Series 5 Addresses in the synchronization:
1. Select Synchronize My Contacts.

2. Click the  button and browse for the Series 5 Data file you want to use (if it is different from C:\
Documents\Data).

In the lower half of the Applications Properties page you must specify which file and profile to use. If you 
are the only person who uses the synchronizer, and have only one Schedule+ agenda, you can use the 
Default file name and profile; otherwise you must specify a specific file name and profile name to use.

Note: The default Schedule+ file is the file automatically created for you when you first run Schedule+. If 
you don’t want to use this file you can create a different one to use.

To use the default Schedule+ file:
· Click on the Synchronize My Appointment Book radio button.

If you do not have an existing Schedule+ file and click the "Synchronize My Appointment Book“ radio 
button when starting a synchronization, Schedule+ will start up briefly and ask you to log on and 
name your default file.

To use another person’s Schedule+ file:
· Click on the Synchronize Other’s Appointment Book radio button and type in the name of the other

person.

Note: You can only select this option if you use the Groupware facility in Schedule+.

To use another Schedule+ file which you created:
· Click on the Synchronize Project Schedule radio button and either type in the path and the name of 

the file, or click on the Browse button  to locate the file.

To specify a profile name:
1. Click the Exchange settings… button.

2. Select a profile from the drop-down list, or type in a new one.

If you are synchronizing with a network installation of Schedule+ and do not know your profile details, 
contact your system administrator.

See also:

Using a custom profile

Choosing which entry types to synchronize with Schedule+

Synchronizing Psion and PC files
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Using a custom profile

If you use Schedule+, or a similar PC scheduler, your PC uses a “profile” to store information about your 
mailbox and other messaging settings.

If you are the only person who uses your PC scheduler and you are not connected to a network there 
may only be one profile, and you can use this (the default) when setting up a synchronization. If you have 
created a custom profile, or if there is more than one on your PC, you will need to tell the Synchronizer 
which one to use.

You might need to specify a custom profile if:

· More than one person uses Schedule+ on your PC.

· You share a network installation of Schedule+.

· You have more than one Schedule+ agenda.

· You want to synchronize with someone else’s agenda.

You can select a custom profile when setting up a new Synchronizer task, or later on. The profile remains 
selected for that task unless you change it again.

To use a custom profile:
1. Select the Agenda Properties page.

2. Click the Exchange Settings... button.

3. Select a profile from the drop-down list, or type in a new one.

If you are synchronizing with a network installation of Schedule+ and do not know your profile details, 
contact your system administrator.

See also:

Synchronizing a Series 5 Agenda with Microsoft Schedule+

Choosing which entry types to synchronize with Schedule+
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Choosing which entry types to synchronize with Schedule+

Your Series 5 Agenda can contain several different types of entry and you can choose to include or 
exclude any of them from the synchronization. You can synchronize the following Series 5 entry types 
with their Schedule+ equivalents:

Series 5 entry type Schedule+ entry type
Day entries Appointments

Anniversaries Annual events

Events Events

To-dos Tasks

To include or exclude entry types from a synchronization:
· On the Entry Types Properties page, place a tick next to each of the entry types you want to include 

in the synchronization.

Click Next to continue.

See also:

Selecting a date range to synchronize with Schedule+

Synchronizing a Series 5 Agenda with Microsoft Schedule+
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Selecting a date range to synchronize with Schedule+

To specify a start date for the synchronization
In the Synchronize entries section of the Psion to PC Properties page, enter a number of days, weeks, 
or months in the From: boxes. All entries within the specified range will be synchronized.

All current and future entries in your Agenda are automatically included when you synchronize, but entries
which are older than the specified start date are excluded. The suggested setting is to synchronize entries
from 3 months in the past, but you might like to change this.

For example:

· If you use an Agenda file mainly as a planner for future events you could set this to 1 week in the 
past.

· If you use an Agenda file as a record of events in your life you could set this to 100 years in the past, 
just the first time you synchronize, in order to include all your existing entries.

When choosing a date, bear in mind:

· How often you synchronize the agenda. If you do not synchronize very often, you might like to 
increase the setting in order to avoid losing “orphaned” entries.

· How often you change entries in the “past”. If you rarely change entries which are in the past, you 
don’t need to check them each time you synchronize.

· How many items you have in your agenda. If you have a very large Agenda file which you 
synchronize frequently, you may find that the Synchronizer task is taking a long time, so you may 
wish to reduce the size of the date range (or exclude certain entry types).

See also:

Synchronizing private and work entries with Schedule+

Synchronizing a Series 5 Agenda with Microsoft Schedule+
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Synchronizing private and work entries with Schedule+

When you set up a Synchronizer task you need to specify your “Work Days and Hours”. Entries outside 
these times will be marked as “private” in Schedule+ and will not be visible to anyone else who has 
access to your Schedule+ agenda - e.g. over a network. This is useful if you have both personal and 
work-related information in your Series 5 Agenda.

However you may prefer to exclude private entries entirely or, if no-one else can access you Schedule+ 
agenda, you can include all entries regardless of their time.

To define Work Days and Hours:
1. On the Psion to PC Properties page, click the Change button.

2. Place a tick next to the days you want to treat as Work Days.

3. Enter start and finish times for your Work Hours.

To select which entries to synchronize:
On the Psion to PC Properties page, select from the following:

· All specified entries. If you select this option, all the Psion entry types you specified on the Entry types
page (see above) will be synchronized, regardless of the time set for the entry.

· All specified entries, but make entries outside work hours private. Entries outside your normal work 
hours set in PsiWin will be synchronized with the PC but will be set to “Private” in Schedule+.

· Only entries within your work hours. Entries outside your specified Work Hours will not be 
synchronized.

Click Next to continue.

See also:

Starting your new synchronization with Schedule+

Synchronizing a Series 5 Agenda with Microsoft Schedule+
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Starting your new synchronization with Schedule+

When you have finished setting up your new synchronization you can either synchronize your agendas 
right away, or you can save your settings and synchronize later. You can also create a shortcut to the new
Synchronizer task on your Desktop.

To synchronize agendas:
· Click the Synchronize button.

To save settings and synchronize later:
· Click the Finish button and then close the dialog.

To create a shortcut on your Desktop:
· Select “Create a shortcut on my Desktop”.

Double-click this icon to synchronize the associated agendas.

Do not attempt to disconnect your Series 5 during a synchronization, otherwise information may be lost. If
you have enabled the “Auto switch off” feature on your Series 5 you should either disable it temporarily 
during a synchronization, or else increase the “Switch off after” setting so that sufficient time is allowed for
the synchronization to complete before auto switch-off.

See also:

Synchronizing a Series 5 Agenda with Microsoft Schedule+

Changing Synchronizer task settings

Creating a Desktop shortcut to a Synchronizer task
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Synchronizing a Series 5 Agenda with Microsoft Outlook

If you have Microsoft Outlook on your PC you can synchronize your Series 5 Agenda and address book 
with the appropriate sections in Outlook

Do not attempt to disconnect your Series 5 during a synchronization, otherwise information may be lost. If
you have enabled the “Auto switch off” feature on your Series 5 you should either disable it temporarily 
during a synchronization, or else increase the “Switch off after” setting so that sufficient time is allowed for
the synchronization to complete before auto switch-off.

Note: Microsoft Internet Explorer 4 includes a special “cut-down” version of Outlook called Outlook 
Express. Outlook Express does not have the full time-management features of Outlook 97 and you 
cannot synchronize your Series 5 Agenda with it.

See also: 

Selecting which Series 5 files and Outlook agendas to synchronize

Selecting your PC scheduler

Synchronizing Psion and PC files
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Selecting which Series 5 files and Outlook agendas to synchronize

You can synchronize your Series 5 Agenda, your Series 5 Address book, or both, with Outlook 97. In 
order to do so you must specify, on the Applications Properties page, which files you want to use.

To include your Series 5 Agenda in the synchronization:
1. Select Synchronize My Agenda.

2. Click the  button and browse for the Series 5 Agenda file you want to use (if it is different from C:\
Documents\Agenda).

To include your Series 5 Addresses in the synchronization:
1. Select Synchronize My Contacts.

2. Click the  button and browse for the Series 5 Data file you want to use (if it is different from C:\
Documents\Data).

Selecting Outlook folders
If you have never set up custom folders from within Outlook you can leave the Calendar, Task, and 
Contacts folders set to “Use Default Folder”. If you have created custom folders from within Outlook, 
remove the tick from the appropriate box(es) and enter the names of the folders you want to use for your 
Task and Calendar entries.

· If you have more than one Outlook agenda, or if you want to synchronize with someone else’s 
agenda, click the Exchange Settings... button and either select a profile from the drop-down list, or 
type in a new one.

See also:

Using a custom profile

Synchronizing a Series 5 Agenda with Lotus Organizer
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Using a custom profile

If you use Outlook, or a similar PC scheduler, your PC uses a “profile” to store information about your 
mailbox and other messaging settings.

If you are the only person who uses your PC scheduler and you are not connected to a network there 
may only be one profile, and you can use this (the default) when setting up a synchronization. If you have 
created a custom profile, or if there is more than one on your PC, you will need to tell the Synchronizer 
which one to use.

You might need to specify a custom profile if:

· More than one person uses Outlook on your PC.

· You share a network installation of Outlook.

· You have more than one Outlook agenda.

· You want to synchronize with someone else’s agenda.

You can select a custom profile when setting up a new Synchronizer task, or later on. The profile remains 
selected for that task unless you change it again.

To use a custom profile:
1. Select the Agenda Properties page.

2. Click the Exchange Settings... button.

3. Select a profile from the drop-down list, or type in a new one.

If you are synchronizing with a network installation of Outlook and do not know your profile details, 
contact your system administrator.

Note: Please see Outlook Help for further information, including the use of the Options>> button. 

See also:

Synchronizing a Series 5 Agenda with Microsoft Outlook

Choosing which entry types to synchronize with Outlook
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Choosing which entry types to synchronize with Outlook

Your Series 5 Agenda can contain several different types of entry and you can choose to include or 
exclude any of them from the synchronization. You can synchronize the following Series 5 entry types 
with their Outlook equivalents:

Series 5 entry type Outlook entry type
Day entries Appointments

Anniversaries Annual events

Events Events

To-dos Tasks

To include or exclude entry types from a synchronization:
· On the Entry Types Properties page, place a tick next to each of the entry types you want to include 

in the synchronization and click Next to continue.

See also:

Selecting a date range to synchronize with Outlook

Synchronizing a Series 5 Agenda with Microsoft Outlook
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Selecting a date range to synchronize with Outlook

To specify a start date for the synchronization
In the Synchronize entries section of the Psion to PC Properties page, enter a number of days, weeks, or 
months in the From: boxes. All entries within the specified range will be synchronized.

All current and future entries in your Agenda are automatically included when you synchronize, but entries
which are older than the specified start date are excluded. The suggested setting is to synchronize entries
from 3 months in the past, but you might like to change this.

For example:

· If you use an Agenda file mainly as a planner for future events you could set this to 1 week in the 
past.

· If you use an Agenda file as a record of events in your life you could set this to 100 years in the past, 
just the first time you synchronize, in order to include all your existing entries.

When choosing a date, bear in mind:

· How often you synchronize the agenda. If you do not synchronize very often, you might like to 
increase the setting in order to avoid losing “orphaned” entries.

· How often you change entries in the “past”. If you rarely change entries which are in the past, you 
don’t need to check them each time you synchronize.

· How many items you have in your agenda. If you have a very large Agenda file which you 
synchronize frequently, you may find that the Synchronizer task is taking a long time, so you may 
wish to reduce the size of the date range (or exclude certain entry types).

See also:

Synchronizing private and work entries with Organizer

Synchronizing a Series 5 Agenda with Microsoft Outlook
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Synchronizing private and work entries with Outlook

When you set up a Synchronizer task you need to specify your “Work Days and Hours”. Entries outside 
these times will be marked as “private” in Outlook and will not be visible to anyone else who has access 
to your Outlook agenda - e.g. over a network. This is useful if you have both personal and work-related 
information in your Series 5 Agenda.

However you may prefer to exclude private entries entirely or, if no-one else can access your Outlook 
agenda, you can include all entries regardless of their time.

To define Work Days and Hours:
1. On the Psion to PC Properties page, click the Change button.

2. Place a tick next to the days you want to treat as Work Days.

3. Enter start and finish times for your Work Hours.

To select which entries to synchronize:
On the Psion to PC Properties page, select from the following:

· All specified entries. If you select this option, all the Psion entry types you specified on the Entry types
page (see above) will be synchronized, regardless of the time set for the entry.

· All specified entries, but make entries outside work hours private. Entries outside your normal work 
hours set in PsiWin will be synchronized with the PC but will be set to “Private” in Outlook.

· Only entries within your work hours. Entries outside your specified Work Hours will not be 
synchronized.

Click Next to continue.

See also:

Starting your new synchronization with Outlook

Synchronizing a Series 5 Agenda with Lotus Organizer
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Starting your new synchronization with Outlook

When you have finished setting up your new synchronization you can either synchronize your agendas 
right away, or you can save your settings and synchronize later. You can also create a shortcut to the new
Synchronizer task on your Desktop.

To synchronize agendas:
· Click the Synchronize button.

To save settings and synchronize later:
· Click the Finish button and then close the dialog.

To create a shortcut on your Desktop:
· Select “Create a shortcut on my Desktop”.

Double-click this icon to synchronize the associated agendas.

Do not attempt to disconnect your Series 5 during a synchronization, otherwise information may be lost. If
you have enabled the “Auto switch off” feature on your Series 5 you should either disable it temporarily 
during a synchronization, or else increase the “Switch off after” setting so that sufficient time is allowed for
the synchronization to complete before auto switch-off.

See also:

Synchronizing Series 5 and PC files

Creating and reviewing Synchronizer tasks

Creating a Desktop shortcut to a Synchronizer task
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If a synchronization with Outlook appears to freeze

If your new synchronization appears to freeze at the “Opening databases…Logging on” stage it is 
possible that you have not yet specified the PC Profile that PsiWin should use.

When you set up a synchronization with Outlook a dialog appears asking you to choose a Profile to use. 
Occasionally, however, this dialog is hidden by the “New Synchronization” animation. If your 
synchronization appears to freeze, try minimizing all the open Windows on your Desktop (by clicking the 
Minimize button) to see if the “Select Profile” Window has been hidden. If so, choose a profile (if 
necessary) and click OK. Your synchronization should continue as normal.



Creating a Desktop shortcut to a Synchronizer task

When you have finished setting up a new Synchronizer task you can choose to create a shortcut on the 
Desktop. Selecting this option will put a new icon on your Desktop, initially called “Shortcut to new 
synchronization”. Double-clicking on this icon will start the associated synchronization.

You can rename this icon by clicking once on the name and pressing the F2 key (press Enter when you 
have renamed it).

· You can also delete the icon, if you like, without affecting the actual synchronizer task.

See also:

Synchronizing Series 5 and PC files

Synchronizing Psion and PC files
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Synchronizing Series 5 and PC files

You can start synchronization from the My Psion icon on the Desktop or in Windows Explorer. Each time 
you synchronize a Series 5 Agenda and/or address book with a PC Scheduler they are compared and 
both are updated to reflect changes in each other.

To synchronize Series 5 and PC files:
If you checked the “Create a shortcut icon on the Desktop” icon when setting up the synchronization, 
simply double-click this icon.

If you did not create a shortcut icon on the Desktop:

1. Double-click the Synchronize Psion icon.

The Psion Synchronizer window opens, showing all the tasks you have set up.

2. Check the box next to each of the Synchronizer tasks you want to update.

3. Click the Synchronize button.

Tip: If your Agenda or address book are quite large and contain a lot of entries, the synchronization may 
take some time to complete. You might like to reduce the amount of time taken for future updates of the 
same files by reducing the range of entries included in the task. See Setting Psion to PC Properties.

When synchronization is complete, both files will be up-to-date with each other.

Do not attempt to disconnect your Series 5 during a synchronization, otherwise information may be lost. If
you have enabled the “Auto switch off” feature on your Series 5 you should either disable it temporarily 
during a synchronization, or else increase the “Switch off after” setting so that sufficient time is allowed for
the synchronization to complete before auto switch-off.

See also:

Synchronizing Psion and PC files

Automatic synchronization

Changing Synchronizer task settings

Selecting your PC scheduler
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Viewing the log file for a synchronization

After you have synchronized your Series 5 and PC agendas for the first time, each subsequent 
synchronization creates a report log file on your PC detailing the changes that were made and any 
conflicts encountered. If any records were not synchronized correctly, the log file will tell you this. You can 
also have the log file copied on to the Series 5, if you wish.

Note: If you want the log file to be copied to your Series 5 you must first create a “C:\Logs\Synchro” folder
(see below). 

You might like to get into the habit of checking the log file after each synchronization.

To view the log file on the PC:
1. Double-click the Synchronize Psion icon on the Desktop.

2. Highlight the appropriate task and click the Properties button.

3. On the Summary Properties page, click the View log button.

To create a Logs folder on your Series 5:
1. Tap the New Folder button, or select the Folder command from the File - Create new menu, in the 

Series 5’s System screen.

2. Name the folder Logs and then tap the OK button.

3. Open the Logs folder and create a new folder within it (as above) called Synchro.

To view the log file on the Series 5:
· Tap the icon named <Agenda>.srp in the C:\Logs\Synchro folder which you created. 

The log file opens in Series 5 Word format.

Note: If you have more than one Agenda on your Series 5 you must make sure they all have different 
names, otherwise they will all have the same log file.

See also:

Synchronizing Psion and PC files

Creating and reviewing Synchronizer tasks
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Synchronizing all agendas on a Series 5

You can update all Synchronizer tasks for the currently connected Series 5 machine at the same time.

To synchronize all agendas on the current machine:
· Right-click the My Psion icon on the Desktop and click Synchronize.

You can also synchronize all tasks from within Windows Explorer by selecting the My Psion icon and 
clicking the Synchronize All icon on the Toolbar.

Note: If the Explorer Toolbar is not visible, you can enable it by clicking Toolbar on the View menu.

Do not attempt to disconnect your Series 5 during a synchronization, otherwise information may be lost. If
you have enabled the “Auto switch off” feature on your Series 5 you should either disable it temporarily 
during a synchronization, or else increase the “Switch off after” setting so that sufficient time is allowed for
the synchronization to complete before auto switch-off.

See also:

Automatic synchronization

Synchronizing Psion and PC files
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Synchronizing Address books

You can use PsiWin to synchronize your Series 5 Address book with the Contacts in your PC scheduler.

Note: before you synchronize your Series 5 address book you should check to confirm that each of the 
labels contains the correct type of information - e.g. that your “Fax” label does not contain any information
which belongs in the “Address” label. Doing so can help save time later, in the event that any information 
does not transfer across correctly.

To synchronize your Series 5 and PC address books
· Either:

– Create a new synchronization (see Setting up a synchronization with the wizard) and ensure that 
you select the “Synchronize my Contacts” option in the Applications Properties page, or:

– Edit an existing Synchronizer task (see Changing Synchronizer task settings) and select the 
“Synchronize my Contacts” option in the Applications Properties page.

When the contact synchronization is complete, the resulting file is copied back to your Series 5.

· If there has been any change to the label structure as a result of the synchronization, your original 
address book is copied into the synchronization folder on your PC (e.g. to C:\Psion\Username\
Synchro\) and renamed with a .bak extension - before you delete this old file you might like to check 
the new file..

Note: you may not be able to include all the information in your Contacts lists in the synchronization. 
PsiWin can synchronize up to 20 different Series 5 labels or PC scheduler “fields”, but some PC 
schedulers may not contain all 20 of the available fields.

See also:

Assigning unrecognized labels

Synchronizing Psion and PC files

Creating a new label on the Series 5

Creating and reviewing Synchronizer tasks



Assigning unrecognized labels

When you set up a new Contacts synchronization, PsiWin looks at the labels that you have in your 
Series 5 database and compares them to the fields    in your PC scheduler. Those that match, or bear a 
very close resemblance, are automatically linked. If PsiWin finds a label in your Series 5 database that it 
does not recognize, you will be asked to select from the remaining fields    available in the Synchronizer.

Note: Some PC scheduler fields cannot be included in a synchronization.

To assign an unidentified label:
1 Click on any of the listed labels. An arrow appears, indicating a drop-down list of choices.

2 Click the arrow to display the unassigned fields in your PC scheduler.

3 Select from the unassigned fields, or click <ignore> if you do not want to include the information 
contained in the selected label in the synchronization.

To check which labels are already set up:
· Click the Advanced… button. PsiWin displays a list of the fields in your scheduler which you can 

synchronize, and the Psion labels they are currently matched to.

Note: If you add a new label to your Series 5 address book after you have synchronized it, it will be 
included the next time you synchronize.

To change the assignment of an existing Psion label:
1 Click the Advanced… button to display the fields in your scheduler which you can synchronize and 

the Psion labels they are currently matched to.

2 Select the desired label.

3 Click the arrow to display the unassigned fields.

4 Select from the unassigned fields, or click <ignore> if you do not want to include the selected Psion 
label in the synchronization.

Note: Some PC schedulers cannot contain certain types of information. If you want to make sure that the 
contents of a particular Psion label are synchronized, you should check whether the PC scheduler 
contains the appropriate fields. If not, you should assign your Psion label to field which the PC scheduler 
does contain.

See also:

Changing Synchronizer task settings

Synchronizing Psion and PC files
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Creating a new label on the Series 5

If you have information in your PC scheduler which does not relate to an existing Series 5 label, you can 
create a new label on your Series 5.

To create a new label on your Series 5:
1 On the Psion to PC Properties page, click the Define... button.

2 Click the information type which corresponds to the information in your PC scheduler.

3 Click the Add new label to Psion button.

4 Type a name for the new label, or accept the suggested name.

The new label is added to your Psion address book the next time you synchronize. It will be a “Text” label,
50 characters long.

See also:

Assigning unrecognized labels

Synchronizing Address books
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Automatic synchronization

You can set PsiWin to automatically synchronize your Psion and PC schedulers at regular intervals (when
connected), and set how often you want this to happen. Automatic synchronizations are performed 
minimized .

To synchronize your Psion and PC Agendas automatically:
1. Right-click the My Psion icon and point to Properties.

2. Select the Synchronization tab.

3. Place a tick in the Perform automatic synchronization box to enable the radio buttons.

4. Select from the radio buttons to synchronize:

– Each time connection is made.

– Once per day, the first time you connect.

– Once per week, the first time you connect.

Note: if you have not ticked the Perform automatic synchronization box, the radio buttons will remain 
dimmed.

5. If you want to confirm which files will be used before the synchronization starts each time, place a tick 
in the Show settings before synchronizing box.

6. Press Apply to save your options, or OK to save and close the dialog.

Tip: If you normally power the Series 5 machine with a mains adapter when you are connected to a PC, 
you can set the Automatic switch-off to "If no external power".

See also: 

Synchronizing Series 5 and PC files

Synchronizing Psion and PC files
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Reviewing and editing Synchronizer tasks

You can view and change settings for Synchronizer tasks as well as create new tasks and delete old 
tasks, in the main Synchronization Control Panel.

To open the Synchronization Control Panel:
1. Double-click the My Psion icon.

2. Double-click the Synchronization Control Panel icon.

Tip: To list the details of all your Synchronizer tasks, click the View menu and click Details.

The Synchronization Control Panel lists your Synchronizer tasks in four columns:

· Synchronization lists the tasks which have already been set up on your PC.

· Psion Agenda lists the Psion Agenda files which were used for the Synchronizer tasks, and their 
locations on the Series 5.

· Psion Data lists the Psion Data (e.g. Address book) files which were used for the Synchronizer tasks,
and their locations on the Series 5.

· PC lists the PC schedulers which were used for the Synchronizer tasks, and the file names (if 
applicable).

· Last Synchronized Date shows when each set of files was last synchronized.

To view or change settings for a Synchronizer task:
1. Right-click on the appropriate task and point to Properties.

The Summary page displays information about your selected task. 

2. Select the Applications, Psion to PC or File Types tabs.

3. Make any changes, as required, and click OK to confirm or Cancel to abandon changes.

See also:

Setting Applications Properties

Setting Psion to PC Properties

Setting Entry Types Properties

Changing Synchronizer task settings

Synchronizing Psion and PC files
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Changing Synchronizer task settings

You can check your Synchronizer task settings, and change them if necessary, by viewing the Properties 
pages.

To review or change settings for Synchronizer tasks:
1. Double-click the My Psion icon to open the My Psion window.

2. Double-click the Synchronizer icon to open the main Synchronizer window.

3. Right-click the icon for the appropriate Synchronizer task and click Properties.

4. Edit the entries on the appropriate pages as required.

Please follow the links below for further information.

· Follow this link for information on Setting Applications Properties

· Follow this link for information on Setting Psion to PC Properties

· Follow this link for information on Setting Entry Types Properties

· Follow this link for information on Summarizing Synchronizer properties

See also:

Synchronizing Psion and PC files

Automatic synchronization

Quick guide to PsiWin



Setting Applications Properties

You can choose which Psion and PC files to synchronize, and enter other information related to your log-
in and network (if appropriate) on the Applications Properties page. The exact information required 
varies between Organizer, Schedule+ and Outlook.

See also:

Selecting which Series 5 files and Organizer agendas to synchronize

Selecting which Series 5 files and Schedule+ agendas to synchronize

Selecting which Series 5 files and Outlook agendas to synchronize
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Setting Psion to PC Properties

You can enter your work days and hours, include or exclude entries outside these hours, and specify a 
start date for synchronized entries, on the Psion to PC Properties page. For further details please follow 
the appropriate link below, depending on whether you are using Organizer, Schedule+ or Outlook.

See also:

Synchronizing private and work entries with Organizer

Synchronizing private and work entries with Schedule+

Synchronizing private and work entries with Outlook
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Setting Entry Types Properties

You can choose which entry types to include in the synchronization and specify a destination section or 
folder (if appropriate) on the Entry Types Properties page. For further details please follow the 
appropriate link below, depending on whether you are using Organizer, Schedule+ or Outlook.

See also:

Choosing which entry types to synchronize with Organizer

Choosing which entry types to synchronize with Schedule+

Choosing which entry types to synchronize with Outlook
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Summarizing Synchronizer properties

The Summary Properties page gives a brief overview of the details of the current synchronization task 
and also contains a button to start synchronization. If you have already synchronized the current task you 
can view a log file which details all the changes that were made by clicking the View Log button (see 
Viewing the log file for a synchronization).

For further details please follow the appropriate link below, depending on whether you are using 
Organizer, Schedule+ or Outlook.

See also:

Selecting which Series 5 files and Organizer agendas to synchronize

Synchronizing a Series 5 Agenda with Microsoft Schedule+

Starting your new synchronization with Outlook
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Synchronizing a number of agendas

You can have as many different synchronized Agendas as you want, but you must set up a separate task 
for each one.

If you have more than one Agenda on your Series 5 you must make sure they all have different names, 
otherwise they will all have the same report log file (see Viewing the log file for a synchronization).

PsiWin can synchronize with Microsoft Schedule, Lotus Organizer, and Microsoft Outlook.

You can synchronize a Series 5 Agenda with:

· A single PC scheduler on a single PC.

· Multiple PC schedulers on different PCs (e.g. at home and at work). These might be the same type of 
scheduler, or different ones.

You can synchronize multiple Series 5 Agendas with:

· A network installation of a PC scheduler (e.g. several employees’ work Agendas).

· A single PC scheduler on a single PC (e.g. two separate Agenda files on one Series 5).

· Multiple PC schedulers on different PCs (e.g. a work Agenda synchronizing with an office installation 
of Organizer, and a personal Agenda synchronizing with Outlook on your PC at home).

Note: If you have several Synchronizer tasks set up on the same PC you should ensure that each has a 
unique and descriptive name, e.g. “Maggie’s Series 5 Work Agenda”.

See also:

Synchronizing Psion and PC files

Automatic synchronization

Synchronizing all agendas on a Series 5
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Setting general Synchronizer options

You can set PsiWin to automatically synchronize your Psion and PC schedulers at regular intervals (when
connected), and set how often you want this to happen. Automatic synchronizations are performed 
minimized

To synchronize your Psion and PC Agendas automatically:
· Check the Perform automatic synchronization box and set the options as appropriate.

See Automatic synchronization for further information.

PsiWin can synchronize with Lotus Organizer, Microsoft Schedule+, and Microsoft Outlook. If you always 
use the same PC Scheduler you can remove the others from the list of supported applications.

To remove a PC scheduler from the list of supported applications:
1. Right-click on the My Psion icon and select Properties.

2. Select the Synchronization tab.

3. In the centre portion of the window, which contains a list of all the PC applications you are currently 
using, select the scheduler you want to remove.

4. Click Remove to remove the selected scheduler from the list of applications you are currently using.

To add a PC scheduler to the list of supported PC applications:
1. Right-click the My Psion icon and select Properties.

2. Select the Synchronization tab.

3. In the upper portion of the window, which contains a list of all the PC applications you can use, select 
the scheduler you want to add.

4. Click Select to add the PC scheduler to the list of applications you are currently using.

Note: If you selected the “Always use this application. Don’t show this dialog again” option when setting 
up a Synchronizer task with Outlook, and later decide you want to use a different scheduler, you can re-
enable this dialog by the same method.

To enable automatic synchronization:
1. Right-click on the My Psion icon and select Properties.

2. Select the Synchronization tab.

3. In the lower portion of the window, which contains a list of all the PC applications you are currently 
using, select the scheduler you want to remove.

4. Click Remove to remove the selected scheduler from the list of applications you are currently using.

See also:

If a synchronization with Outlook appears to freeze

Synchronizing Psion and PC files

Psion to PC file compatibility
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Troubleshooting and error messages

A note about automatic switch off
If you have set the Psion to automatically switch off after a certain period of time, and also enabled the 
"back up each time connection is made" option, PsiWin will attempt to back up each time you reconnect. 
A similar problem may occur if the Psion automatically switches off during Agenda synchronization. When 
you reconnect PsiWin will start an automatic backup, interfering with the synchronization process. It is 
therefore not advisable to enable both the "Back up each time connection is made" option in PsiWin and 
the "Auto switch-off" option on the Psion.

Note: If you are having difficulty synchronizing to a remote PC this may be due to network problems. 
Please contact your network administrator for assistance.

· If you are unsuccessful in synchronizing your Series 5 Agenda with a new, empty PC file you may 
wish to delete the new file and try again. For further information see Deleting a newly-created PC 
Scheduler file

· If you experience problems synchronizing your Series 5 and PC agendas you can check the 
Synchronizer log file to review the changes which have been made. For further information see 
Viewing the log file for a synchronization.

· If incomplete information is transferred to your Series 5, the label definitions may be too small. For 
further information see Contacts not completely transferred to Series 5

The following error messages may also appear during Agenda synchronization:

Specified file does not exist

Synchronizer cannot access the required directory

Unable to open file

Synchronization has stopped

Last synchronization date mismatch

More than 20 deletions



Deleting a newly-created PC Scheduler file

If you create a new PC scheduler file to synchronize your Series 5 Agenda with, and have problems 
synchronizing successfully, you may want to delete the new file from your PC and start again. If you do 
not know what the file was called, or where to find it, you can follow these instructions.

If your PC Scheduler is installed on a network you should contact your system administrator for details on 
file names and locations.

To delete a newly-created Organizer or Schedule+ file
1. Open Windows Explorer and left-click on My Computer.

2. Press the F3 key.

3. In the Find:All Files dialog, select the Name & Location tab.

4. In the Named: box:

– For Organizer, type *.or?
– For Schedule+, type *.sc? *.cal

5. Select the Date modified tab.

6. Select Find all files created or modified - during the past [1] day(s) and click Find now.

7. Delete (or, if in doubt, rename) any files found by the search process.

For further information, see online Help for Organizer and Schedule+.

To delete a newly-created Outlook calendar
· Refer to Outlook Help for information on deleting your Calendar folder, then create a new one.

See also:

Troubleshooting and error messages

Synchronizing Psion and PC files

Quick guide to PsiWin



Specified file does not exist

Message:
The specified Series 5 file “<filename>” does not exist. Would you like to create it or use an existing file?

Problem:
You have tried to synchronize with a file which does not exist, or no longer exists, on the Series 5. You 
may have renamed or deleted the file, or you may have entered the file name incorrectly on the 
Synchronizer Properties page.

Suggestion:
Click Create new file to synchronize with a new file which will be created on your Series 5. You can 
choose a name and location for the new file.

Click Use Existing file to synchronize with a current file on your Series 5. You can browse the contents of
your Psion disk(s) and select any existing file of the appropriate type.

Click Cancel to abandon the synchronization.



Unable to open file

Message:
Unable to open (file name).

Problem:
You may have tried to synchronize a Series 3/3a/3c Agenda file.

Suggestion:
PsiWin cannot synchronize Series 3/3a/3c Agenda files. Upgrade the file to Series 5 machine format and 
synchronize again.

If you are attempting to synchronize with Lotus Organizer:
Problem:
You may have tried to synchronize with an Organizer file which has not been "initialized", typically if you 
are creating a new file to synchronize with. To initialize an Organizer file you must close it after creating it 
(saving it will not achieve the desired result).

Suggestion:
Close the Organizer file you want to synchronize with.

Problem:
You may have tried to synchronize with an Organizer file which is currently open, and which has been 
saved using the "single user" option. You cannot Synchronize with an open Organizer file unless it has 
been saved using the multi-user option.

Suggestion:
Close the Organizer file you want to synchronize with or use the Save as command and specify multi-
user.



Synchronization has stopped

Message:
The reason the Synchronizer has stopped is, (file name) could not be copied because it is in use by 
another application.

Problem:
This message appears if you try to synchronize an open Agenda file.

Suggestions:
Check that the Agenda is not open on the Series 5.

Check that you do not have the file open in another program, e.g. a text editor.



Last synchronization date mismatch

Message:
The last synchronization date recorded on the Psion does not match the date recorded on the PC. Do you
wish to synchronize from scratch?

Problem:
Before the Synchronizer starts the synchronization process it compares the dates of the two files involved
in the synchronization. If the synchronization date stored on the Series 5 is different from the date stored 
in the Synchronizer you will be given a warning message and asked to confirm that you want to proceed.

Suggestion:
Select Yes to continue or No to stop synchronization and change settings for one of the files.



More than 20 deletions

Message:
The Synchronizer has detected more than 20 deleted entries since you last synchronized. Do you want to
continue with this synchronization and remove them from both Agendas??

Problem:
Before the Synchronizer starts the synchronization process, the number of deletions on the Psion and PC
are checked. If the total is greater than 20 you will be given a warning message and asked to confirm that 
you want to proceed. This guards against accidental deletion of multiple entries, or accidental 
synchronization with a different Agenda file.

Suggestion:
If you see this message, the most likely explanation is that you have deliberately deleted several entries 
from one or other of your Agendas and/or address books. In this case you can click Continue to carry on 
with the synchronization and remove them from the other Agenda as well.

If you have accidentally deleted several entries from an Agenda and want to restore them, you should 
press Cancel and then set up a new synchronization using the same Psion and PC Agendas.

You may also see this message if you have attempted to set up a new synchronization by changing the 
file name specified on the synchronization Properties pages.

If you are uncertain you should press Cancel, to stop synchronization, and then check your Series 5 and 
PC agendas. 



Synchronizer cannot access the required directory

If you are using Lotus Organizer and receive the error message “Synchronizer cannot access the required
directory” you may have two or more conflicting versions of a required file (Orgapi.dll) on your PC.

To check for Orgapi.dll:
1. Open Windows Explorer.

2. Click the My Computer icon in the right-hand pane.

3. Press the F3 key to open the Find:All Files dialog.

4. In the Named: box, type Orgapi.dll and click the Find Now button.

5. Check the dates of the files (in the Modified column) and delete any found files which are older than 
1/12/95.

6. Exit Explorer and reboot your machine.



Contacts not completely transferred to Series 5

If any of the fields in your PC scheduler contain more characters than the maximum number allowed in 
the equivalent label on your Series 5, you may find that some information is lost after synchronization.

Note: any entries which are truncated in this way will be recorded in the log file.

If this happens, you can create a new Data file on your Series 5, with larger labels, and re-synchronize 
with the new file.

See also:

Viewing the log file for a synchronization



Printing

You can print Series 5 files directly to any printer connected to your PC or network without converting 
them to PC file formats. You can also use TrueType fonts in Series 5 Word and Sheet files.

Note: You must have the appropriate TrueType fonts installed on your PC in order to use them.

See also: 

Printing from the Series 5 via a PC

Using TrueType fonts with a Series 5
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Printing from the Series 5 via a PC

You can connect your Series 5 to a PC or network and print to any connected printer, using TrueType 
fonts, without having to convert the file to a PC format.

To do this you need to indicate the printer you want to use and install support for any TrueType fonts you 
want to use on your Series 5.

To install Series 5 support for a Windows printer:
1. Ensure that your PC and Series 5 are connected and that none of your Word and Sheet files on the 

Series 5 are open.

2. Right-click the Connection icon  on the Taskbar and click Properties.
3. Select the Print Options tab.
4. Select the printer you require from the drop-down list of all the printers installed on your PC.
5. Click the Set Printer button to indicate that this is the printer you want to use when printing from 
a Series 5.

If you regularly use the same printer you can improve your results by ticking the Optimize Driver for 
this printer box. This adds "Printer via PC (Printer name)" to the list of printers in your Series 5 Print 
setup dialogs. You should select this printer when printing from your Series 5 via a PC.

Click OK to save any changes and close the dialog.

To print from the Series 5 to a Windows printer:
1. On the Series 5, ensure that the Remote link is on and open the program from which you want to 

print.

2. Select the Print setup... command from the Printing cascade on the File menu.

3. Tap the Printer... button and select Printer via PC from the To list.

If you selected the “Optimize Driver for this printer” option when installing the printer (see above), the 
specific printer will appear in the To list. For best results select this option.

4. Tap the OK button to begin printing.

See also: 

Using TrueType fonts with a Series 5

Removing TrueType font support from a Series 5
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Using TrueType fonts with a Series 5

You can use your PC's TrueType fonts in your Series 5 files. This allows you to create documents on your
Series 5 using these TrueType fonts and print them, via Windows, to any printer connected to your PC or 
network.

To do this you must install support for the desired TrueType fonts onto your Series 5.

To install TrueType font support on your Series 5:
1. Ensure that your PC and Series 5 are connected and that no files are open on the Series 5.

2. Right-click the Connection icon  on the Taskbar and click Properties.
3. Select the Print Options tab.
4. In the left-hand portion of the window is a list of all the TrueType fonts installed on your PC. Left-
click on each font you want to install and click the Add button to add it to the list of fonts which will be 
installed in the right-hand portion of the window.

Tip: You can see a sample of the selected font at the bottom of the page.

5. Repeat step 4 for each additional font, or click Add all to select all the available fonts.

6. Click the Install button to install support for the fonts to your Series 5.

7. Click OK to exit the Properties pages, and then disconnect your Series 5 from your PC.

Support for the selected fonts will be enabled the next time you connect your Series 5 to the PC.

The selected fonts will then appear on your Series 5 in the lists of available fonts in Word and Sheet 
whenever you select Printer via PC as your printer.

You cannot use TrueType fonts to print to a printer that is directly connected to your Series 5, you must 
print via a PC which has the fonts installed on it.

Note: You cannot use "special" fonts, for example Symbols, Wingdings, etc.

Note: Your Series 5 cannot display TrueType fonts on its screen. All text appears as one of the three 
standard screen fonts; Times New Roman, Arial, or Courier, but installed TrueType fonts will print correctly
via a PC.

See also: 

Removing TrueType font support from a Series 5

Printing
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Removing TrueType font support from a Series 5

You can remove support for a TrueType font installed on your Series 5 if you decide you no longer want to
use it.

To remove TrueType fonts from your Series 5:
1. Ensure that none of your Word and Sheet files on the Series 5 are open.

2. Right-click the Connection icon on the Taskbar and click Properties.

3. Select the Print Options tab.

The right-hand portion of the window contains a list of the TrueType fonts which are installed on your 
Series 5.

4. Select the font you want to remove.

5. Click Remove to remove support for the selected font from your Series 5.

6. Click Install to delete support for the selected fonts, or

Click Defaults to remove support for all but the standard Series 5 fonts (Arial, Courier, and Times 
New Roman).

Note: You must have at least one font installed on your Series 5.

See also: 

Printing
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Installing new software onto a Series 5

You can install new programs and software to your Series 5 using the EPOC Install program included with
PsiWin, if the software is prepared for installation in a file with the extension .SIS.

To install new software on your Series 5:
1. Click the Start button, point to Programs, point to PsiWin 2.1 and click Install New Program.

EPOC Install starts. If this is the first time you have used EPOC Install, a few new files are copied to 
your Series 5.

Note: The first time you use EPOC Install to install new software onto your Series 5, a new 
Add/remove icon is added to your Series 5 Control Panel (accessible via the Tools menu in the 
System screen). You can use this Add/remove icon to remove software from your Series 5.

2. Browse for the .SIS file containing the new software.

3. Double-click the .SIS file.

In future, once you have used EPOC Install for the first time, simply double-clicking on an .SIS file in 
Windows Explorer will automatically install the new software.

See also:

Removing software from a Series 5
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Removing software from a Series 5

If you have used EPOC Install to add new programs or software to your Series 5, you can automatically 
remove    all files related to the program from the Series 5 Control panel.

To remove software from a Series 5:
1. In the Series 5 System screen, press the Control panel button on the Toolbar or select the Control 

panel command from the Tools menu.

2. Tap the Add/remove programs icon.

3. Select the desired program and tap the Remove button.

See also:

Installing new software onto a Series 5
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Setting Connections options

You can use PsiWin's advanced connections options to customize the way the Psion machine and PC 
communicate when they are connected and solve connection problems between the Psion and the PC.

You can use PsiWin's connections options to:
· Change the communications port used for the connection between the Psion and the PC.

See Selecting which COM port to use

· Change the Baud rate used for the connection between the Psion and the PC.

See Changing connection speed

· Disable automatic detection of an attached Psion.

See Turning off automatic detection of an attached Psion

· Synchronize the Psion machine and PC clocks automatically on connection.

See Synchronizing Psion and PC clocks

· Access your PC’s drives directly from a Series 3/3a/3c.

See Accessing your PC from a Series 3/3a/3c

See also: 

How to connect and disconnect a Psion
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Setting Connections options (footnote 1)

Baud Rate
The speed at which electronic information travels, typically between two computers or between a 
computer and a printer, measured in bps (bits per second).

Series 5 machines can communicate at Baud rates of up to 115200 bps.



How to connect and disconnect a Psion

PsiWin can automatically detect when you connect a Psion to the PC. The Connection icon in the Taskbar
shows when the Psion is connected.

· When a Psion is connected the Connection icon looks like this: 

· If the Psion has been disconnected the Connection icon looks like this: 

Note: If your Series 5 is set to automatically turn off after a set period of time, the connection to the PC 
will be broken and the link will close. To reconnect, right-click the Connection icon  and click Connect.
If you need to use the COM port for another program, or if you want to connect a different Psion machine,
you can temporarily suspend the link to the Psion. You can also shut down the connection completely.
To close the link to a Psion:
· Right-click the Connection icon  on the Taskbar and click Close.

Note: If you close the link to a Psion you can reconnect it by double-clicking the My Psion icon on the 
Desktop and selecting the Connect command from the Psion menu..

You can also disconnect a Psion from the PC and leave PsiWin open, ready to reconnect.

To disconnect a Psion:
· Right-click the Connection icon  on the Taskbar and click Disconnect from the menu options.

Note: If you do not turn off the link on the Psion machine or unplug the cable, after a few seconds (as 
determined by the Delay between searches setting) PsiWin will reconnect to your Psion unless you have
checked the Manually connect, no auto searching option. You can change these and other options by 
clicking Properties on the menu displayed when you right-click the My Psion icon. Refer to Setting 
Connections options for more information on this.

To reconnect a Psion to the PC:
· Right-click the Connection icon  on the Taskbar and click Connect.

See also:

Setting Connections options
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Accessing your PC from a Series 3/3a/3c

You can access your PC’s drives directly from a Series 3/3a/3c by enabling two-way connection (this 
feature is initially disabled to improve Series 3 performance when connected).

You can use this feature to save Series 3 files to a PC in a different format, for example, to save a Data 
file as plain text, or a password-protected Word file as Rich Text.

Note: You cannot directly access your PC drives from a Series 5 machine.

To access a PC from your Series 3/3a/3c:
1. Right-click the My Psion icon and click Properties.

2. Select the Connections tab.

3. Place a tick in the Allow Psion to see PC box.

To save a Series 3/3a/3c file on the PC in a different format:
1. Connect the Series 3/3a/3c to the PC and open the file you want to save to the PC.

2. Select the Save as command from the application's File menu.

3. Type REM followed by two colons (REM::), then the drive letter and destination folder on the PC, then 
the desired file name, and finally the extension for the appropriate file type.

i.e. REM::C:\Psion\Files\Word.rtf
4. Select the desired File type (Normal, Text, Data or Rich Text) and press Enter to save the file.

See also: 

Setting Connections options

Upgrading files to Series 5 format
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Selecting which COM port to use

Usually, it does not matter which COM port on your PC you use to connect your Psion. PsiWin checks 
each port in turn in order to find a connected Psion.

Some devices may be using the COM port in such a way that PsiWin is not able to establish a connection
with a Psion. This may happen if you have certain modems or a serial mouse attached to your PC, and 
also if your PC has internal devices which can access the COM port (e.g. an internal modem).

If this happens, it may not be possible for PsiWin to connect, or the connection may be very slow. It is 
therefore a good idea to tell PsiWin to ignore some ports, so that conflicts with other devices do not occur.

To select which COM ports you want PsiWin to search:
1. Right-click the My Psion icon and click Properties.

2. Select the Connections tab.

3. Uncheck any boxes in the Settings dialog for the COM ports used by other devices. Make sure that 
you check the boxes for any ports that you might use to connect a Psion.

To make future connections quicker, PsiWin checks the COM ports in a particular order when you 
disconnect and then re-connect a Psion. First, PsiWin checks the port on which a Psion was last 
connected, and then it checks the other ports in the order of the list in the Connections page of the dialog.

To change the order in which PsiWin searches through COM ports:
· Highlight a port and use the up  and down 

 buttons to nudge the port up or down through the list.

See also: 

Setting Connections options
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Changing connection speed

When PsiWin finds a Psion connected to a COM port it automatically sets its speed to the same Baud 
rate as the connected Psion.

If the Psion and PC are having difficulty communicating, try lowering the Baud rate on the Psion. If 
communication is still poor you can manually set a matching Baud rate for PsiWin.

To manually set the Baud rate:
1. Right-click the My Psion icon and click Properties.

2. Select the Connections tab.

3. Select the speed you require from the Baud rate drop-down list.

See also: 

Setting Connections options
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Changing connection speed (footnote 1)

Baud Rate
The speed at which electronic information travels, typically between two computers or between a 
computer and a printer, measured in bps (bits per second).

Series 5 machines can communicate at Baud rates of up to 115200 bps.



Turning off automatic detection of an attached Psion

PsiWin automatically searches the available communications ports for a connected Psion machine. If you 
are experiencing problems connecting, or if another program appears to be interfering with the connection
process, you can turn off the auto detection mechanism.

To turn off the automatic detection of a connected Psion machine:
1. Right-click the My Psion icon and click Properties.

2. Select the Connections tab.

3. Check the Manually connect, no auto detection option.

See also:

Setting Connections options

Quick guide to PsiWin



Synchronizing Psion and PC clocks

Your Psion has a very accurate internal clock. However it can become inaccurate as a result of power 
failure or machine reset, and you can set PsiWin to automatically synchronize the internal clock with that 
of the PC each time you connect.

Tip: Selecting this option will also ensure that the Series 5 and PC Agendas are in accordance when you 
synchronize Agenda files.

Tip: If your PC automatically compensates for Summer and Winter times, selecting this option will also 
update the clock on the Psion when you connect.

To set automatic clock synchronization:
1. Right-click the My Psion icon and click Properties.

2. Select the Connections tab.

3. Place a tick in the Synchronize PC and Psion clocks at connection box.

See also: 

Setting Connections options
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Jump

This is an example of a jump to another window. Click the Back button to return to the previous Help 
topic.




